User’s Manual

University of Hartford

Version 2.6
December 4, 2014

MY CASCADE SERVER INFORMATION

URL: http://cms-app-dev.hartford.edu:8080
Username: [Enter]
Initial Password: [Enter]
A. TABLE OF CONTENTS

B. REVISION HISTORY .................................................................................................................. 5

1. BASICS ..................................................................................................................................... 6
   1.1. ABOUT THIS USER'S MANUAL ....................................................................................... 6
   1.2. CASCADE SERVER SYSTEM REQUIREMENTS .............................................................. 6
   1.3. LOG IN AND OUT ............................................................................................................. 6
   1.4. CHANGE YOUR PASSWORD ........................................................................................... 7
   1.5. ONLINE HELP ................................................................................................................. 7
   1.6. BOOKMARK / SHARE ASSETS ...................................................................................... 7
   1.7. QUICK LINKS .................................................................................................................... 7
   1.8. MULTIPLE SITES ............................................................................................................ 7
      1.8.1. Change Sites .............................................................................................................. 7
      1.8.2. Cross-Site Linking and Asset Sharing ...................................................................... 7
   1.9. TOP NAVIGATION MENU .............................................................................................. 7
   1.10. ASSET TREE .................................................................................................................. 8
      1.10.1. Icon Definitions ........................................................................................................ 8
      1.10.2. Open / Close Folders ............................................................................................. 8
      1.10.3. Context Menu .......................................................................................................... 8
   1.11. DASHBOARD / HOME AREA ........................................................................................ 8
   1.12. VIEW AN ASSET ............................................................................................................ 9
   1.13. ASSET ACTION TOOLBAR ........................................................................................... 9

2. EDIT A PAGE ............................................................................................................................. 10
   2.1. PAGE TITLES .................................................................................................................... 10
   2.2. THE CONTENT EDITOR .................................................................................................... 10
      2.2.1. Helpful Tips ............................................................................................................. 10
      2.2.2. Copying & Pasting From an External Source .............................................................. 11
   2.3. IMAGES ............................................................................................................................ 11
      2.3.1. Internal ..................................................................................................................... 11
      2.3.2. External .................................................................................................................... 12
      2.3.3. Upload an Image ..................................................................................................... 13
   2.4. LINKS ............................................................................................................................... 13
      2.4.1. Link to Page .............................................................................................................. 13
      2.4.2. Link to File ............................................................................................................... 14
      2.4.3. Link to External Web Site ....................................................................................... 14
      2.4.4. Link to Email Address ............................................................................................. 15
      2.4.5. Create Anchor Links .............................................................................................. 16
   2.5. EMBED MEDIA .................................................................................................................. 16
   2.6. HTML EDITING ............................................................................................................... 18
   2.7. TABLES ............................................................................................................................ 18
      2.7.1. Advanced Options .................................................................................................... 19
      2.7.2. Edit Rows and Columns ......................................................................................... 19
   2.8. ADVANCED OPTIONS ..................................................................................................... 19
   2.9. METADATA ....................................................................................................................... 20
   2.10. SYSTEM INFORMATION .............................................................................................. 20
   2.11. SAVE YOUR PAGE ........................................................................................................ 21
      2.11.1. Save as Draft .......................................................................................................... 21
      2.11.2. Save as a Final Copy ............................................................................................. 21
11. USABILITY GUIDELINES ........................................................................................................ 41

12. NEWS ................................................................................................................................. 42
   12.1. ADD A PRESS RELEASE ............................................................................................... 42
   12.2. PRESS RELEASE ARCHIVE ....................................................................................... 43
   12.3. U OF H IN THE NEWS ARCHIVE .............................................................................. 43
   12.4. NEWS LANDING PAGE ............................................................................................... 44
   12.5. MEDIA CONTACTS ..................................................................................................... 44
   12.6. EXPERT ADVICE ......................................................................................................... 45
   12.7. ADDING A PRESS RELEASE YEAR ........................................................................... 45
   12.8. MAINTAINING CATEGORIES ....................................................................................... 46
   12.9. PUBLISHING .............................................................................................................. 47

13. MY STORY ARCHIVE ......................................................................................................... 47
   13.1. ADD A STORY .............................................................................................................. 47
   13.2. PUBLISHING .............................................................................................................. 48

14. RIGHT COLUMN CONTENT ............................................................................................... 49
   14.1. CREATE A CALLOUT BLOCK ....................................................................................... 49
   14.2. CREATE A LINK LIST ................................................................................................... 50
   14.3. CREATE A CONTENT BLOCK ...................................................................................... 50
   14.4. CREATE A VIDEO BLOCK ........................................................................................... 50
   14.5. DISPLAY CONTENT BLOCK ON A PAGE ..................................................................... 51
   14.6. PUBLISHING .............................................................................................................. 51
       14.6.1. Adding/Modifying a Content Block .................................................................... 52
       14.6.2. Displaying Content on a Page ........................................................................... 52

15. GENERAL WORKFLOW ..................................................................................................... 53
   15.1. CONTRIBUTORS ............................................................................................................ 54
       15.1.1. Submit New Content and Start the Workflow ....................................................... 54
       15.1.2. Rejected Content ............................................................................................... 54
   15.2. PUBLISHER (EDIT / REJECT / SEND TO EDITORS / SEND TO WEB DEPARTMENT / PUBLISH) .................................................................................................................. 55
       15.2.1. Approve for Publish ............................................................................................ 55
       15.2.2. Reject to Contributor ......................................................................................... 56
       15.2.3. Edit Content ....................................................................................................... 56
       15.2.4. Send to Editors ................................................................................................. 56
       15.2.5. Send to Web Department ................................................................................. 56
   15.3. EDITOR REVIEW (EDIT / REJECT / SEND TO WEB DEPARTMENT / APPROVE FOR PUBLISH) .......................................................................................................................... 56
       15.3.1. Approve for Publish ............................................................................................ 57
       15.3.2. Reject to Contributor ......................................................................................... 57
       15.3.3. Edit Content ....................................................................................................... 57
       15.3.4. Send to Web Department ................................................................................. 57
   15.4. WEB DEPARTMENT REVIEW (EDIT / REJECT / SEND TO EDITORS / APPROVE FOR PUBLISH) .......................................................................................................................... 57
       15.4.1. Approve for Publish ............................................................................................ 58
       15.4.2. Reject to Contributor ......................................................................................... 58
       15.4.3. Edit Content ....................................................................................................... 58
       15.4.4. Send to Editors ................................................................................................. 58

16. RESLIFE WORKFLOW ..................................................................................................... 59
16.1. CONTRIBUTOR .................................................................................................................. 59
  16.1.1. Submit New Content and Start the Workflow .......................................................... 59
  16.1.2. Rejected Content ....................................................................................................... 59
16.2. PUBLISHER ..................................................................................................................... 60
  16.2.1. Edit Asset .................................................................................................................. 60
  16.2.2. Reject to Contributor .............................................................................................. 61
  16.2.3. Approve and Send to Editor ..................................................................................... 61
16.3. EDITOR .............................................................................................................................. 61
  16.3.1. Edit Asset .................................................................................................................. 61
  16.3.2. Reject to Contributor .............................................................................................. 62
  16.3.3. Reject to Publisher .................................................................................................. 62
  16.3.4. Approve and Send to Designer ................................................................................ 62
16.4. DESIGNER ....................................................................................................................... 63
  16.4.1. Edit Asset .................................................................................................................. 63
  16.4.2. Reject to Contributor .............................................................................................. 63
  16.4.3. Reject to Publisher .................................................................................................. 64
  16.4.4. Reject to Editor ....................................................................................................... 64
  16.4.5. Approve and Publish .............................................................................................. 64
16.5. RIGHT COLUMN WORKFLOW ..................................................................................... 64
17. HOMEPAGE ......................................................................................................................... 65
  17.1. SPECIAL MESSAGE ...................................................................................................... 65
  17.2. AREAS OF STUDY ......................................................................................................... 66
    17.2.1. All Areas of Study .................................................................................................... 66
    17.2.2. Slideshow ............................................................................................................... 66
  17.3. MOBILE ICONS ........................................................................................................... 66
18. EMERGENCY SITE ............................................................................................................... 67
  18.1. EMERGENCY MESSAGE .............................................................................................. 67
    18.1.1. Activate .................................................................................................................. 67
    18.1.2. Deactivate .............................................................................................................. 68
  18.2. POST-EMERGENCY MESSAGE .................................................................................. 68
  18.3. PRESIDENT/PROVOST TRAGEDY MESSAGE ........................................................... 68
    18.3.1. Activate .................................................................................................................. 68
    18.3.2. Deactivate .............................................................................................................. 68
# B. Revision History

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>J. Klingman</td>
<td>12/23/2009</td>
<td>Original Version (1.0)</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>03/17/2010</td>
<td>Added Workflow</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>04/01/2011</td>
<td>Revised to v.2.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added standard Cascade Server user’s manual material</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Customized user instructions now begin in Section 12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Section 6, “Creating a New Link in the Navigation”</td>
</tr>
<tr>
<td>A Fowler</td>
<td>12/14/2011</td>
<td>Added mini-calendar info</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>01/26/2012</td>
<td>Modified Section 12, “Campus Calendar”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modified Section 14, “My Story Archive”</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>02/09/2012</td>
<td>Added Section 12.12, “Calendar Event Feed”</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>01/11/2013</td>
<td>Added Section 18, “Emergency Site”</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>02/26/2013</td>
<td>Added Section 17, “ResLife Workflow”</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>04/08/2013</td>
<td>Added Section 17.5, “Right Column Workflow”</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>10/30/2014</td>
<td>Updated manual to support redesign changes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 2.7: Table classes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 12: Removed Calendar</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 17: Added Homepage instructions</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>12/04/2014</td>
<td>Version 2.6: Added Section 14.4, “Create Video Blocks” for right column</td>
</tr>
</tbody>
</table>
1. **BASICS**

1.1. **About This User’s Manual**

This manual is organized to provide you with helpful information about using the software. In order to provide our clients with the most helpful information, only relevant topics are covered in this manual. If you have a question about any feature not covered in this manual, please do not hesitate to contact us. This manual assumes that:

- You have a basic understanding of your computing environment and that you are familiar with common file options such as open, close, and save files.
- You are able to use the Internet and have experience using a web browser.
- Also, it is assumed that the user is knowledgeable in basic image formatting for use on the Web.
- The user has a good understanding of Microsoft Word® and its functions.

1.2. **Cascade Server System Requirements**

You can access Cascade Server to update your site from anywhere you have access to the Internet. Your computer will need to meet or exceed the following software requirements:

- Web Browser:
  - Internet Explorer 7+
  - Firefox 3.6+
  - Safari 3+
  - Chrome
- Screen resolution of 1024 x 768 or higher
- Network connection
- Pop-up Blockers: Cascade Server relies heavily on the use of pop-up windows. You will need to configure your pop-up blocker to allow all pop-ups from this site (http://cms-app-dev.hartford.edu:8080).

1.3. **Log In and Out**

Each person using the software needs a username and password to access the system. For security purposes, inactive users will automatically be logged off after a period of time. Users should log off when not using the system.

**To Log In:**

1. In your browser, go to http://cms-app-dev.hartford.edu:8080 (bookmark this page).
2. Enter your Username and your Password.
3. If you wish for the system to automatically log you in next time, check “Remember me”. Note that for this to work, you should not click “Logout”; otherwise, you will need to log in next time. Note that the system will remember you for two weeks.
4. Click Login.

**To Log Out:** Select the Logout hyperlink in either the upper right-hand corner or the bottom right-hand corner.
1.4. **Change Your Password**

1. In the upper right-hand corner navigation, click **My Settings**.

2. In the “Change Password” section, type in your new password (twice), and then click **Submit**.

   **NOTE:** Your password is case-sensitive.

1.5. **Online Help**

At any time, you may access the Online Help section by clicking on the “Help” link in the upper right-hand corner.

**NOTE:** This online help is provided by Hannon Hill, and not Beacon Technologies.

1.6. **Bookmark / Share Assets**

Cascade Server allows you to bookmark any asset in your browser for easy editing. Just navigate to the desired asset, and bookmark that page. You can also email the URL of an asset. This is useful if you would like another colleague to review a page within Cascade Server. Simply copy the URL of the desired asset and paste into an email. Please note that the recipient will be required to log into Cascade Server in order to view the asset.

1.7. **Quick Links**

A menu containing links to frequently-used tools in Cascade Server can be found in the upper right-hand corner navigation by clicking on **Quick Links**. A menu will pull down containing links to Dashboard items (see Section 1.11 below) and your recent history (for the current session only).

1.8. **Multiple Sites**

**NOTE:** This section is only applicable to users who have access to two or more sites in Cascade Server.

1.8.1. **Change Sites**

You can switch sites by using the Site Selection Menu at the top of the screen.

1.8.2. **Cross-Site Linking and Asset Sharing**

With multiple sites in Cascade Server, you can create links between sites, as well as call (share) assets from other sites. When inserting an image or link, use the Site Selection Menu at the top of the asset selection popup window to select an asset from another site. Inserting images and links will be covered in Section 2.3.

1.9. **Top Navigation Menu**

The top navigation menu is in the blue area at the top of your browser. To navigate the top navigation menu sections, click on the item. If the menu option has a double arrow, a drop down menu of options for that section will appear. You must then select the appropriate option. Each menu option will be covered in later sections of this manual.
1.10. Asset Tree

A tree of assets and folders may be explored in the left navigation frame. This area functions similarly to Windows Explorer.

1.10.1. Icon Definitions

Each icon represents a different kind of asset in Cascade Server, defined below:

- Folder
- Page
- File (Images, PDFs, Office Documents, etc.)
- Navigation Link (select sites only)
- External Link (select sites only)

1.10.2. Open / Close Folders

There are two ways to open and close folders:

1. Click on the folder icon or name to fully open the folder and view details in the right column.
2. Click on the icon to quickly open the folder.
3. To close a folder, click on the folder’s icon.

1.10.3. Context Menu

Each asset in the asset tree has a menu containing common actions for that type of asset, such as Edit, Publish, etc. To view the Context Menu for an asset, simply mouse over the asset, and then click on the arrow that appears (see the screenshot to the right). Then click on the desired action for that asset.

1.11. Dashboard / Home Area

Upon logging in, every user is greeted with a personalized dashboard showing messages, current workflows, assets checked out, and much more general information. The Dashboard, also referred to as the Home Area, is used to supply the user with a summary of the activities that require user attention.
There are five relevant tabs on the home page:

- **Dashboard**: The Dashboard lists a summary of the information on the other four tabs.
- **Messages**: Shows you any messages waiting for you. You will find publish confirmation messages in this area.
- **Workflows**: Shows you any assets that are waiting for an action from you in a workflow.
- **Drafts**: This tab shows you any assets you currently have saved in Draft mode. See Section 2.11.1 below for more information.
- **Recycle Bin**: When deleting assets, they will be put into the Recycle Bin. See Section 10 below for more information.

The dashboard can be accessed at any time by selecting **Home** in the upper left-hand corner.

### 1.12. View an Asset

In order to browse your site, simply click on the desired folder on the left side to expand the folder tree. Once the folder expands, the sub-folders and assets are displayed in the same directory structure that exists when published. Clicking on a page in the folder such as index will bring up a preview of that page in the right frame, just as it would appear online.

### 1.13. Asset Action Toolbar

The Asset Action Toolbar is displayed when editing an asset. Each function will be covered in more detail later.

**View**: Shows the design view of the page.
- **Layout**: Shows the layout of the page within Cascade Server.
- **Preview**: Shows the page as it will look once published.
- **Live**: Shows the corresponding page on your live Web site. Clicking this link allows you to view a page that you just published without having to leave Cascade Server.
- **Properties**: Shows information for the current page.
- **Configurations**: Shows the file structure of the page. Users should ignore this option.

**Edit**: Start editing the page’s content and metadata. Clicking this will start the editor. See Section 2.
- **Content**: The area where you edit your content.
- **Metadata**: Edits search engine metadata, such as keywords and descriptions.
- **System**: Toggle whether this asset should be published or indexed.
- **Configurations**: Shows the page’s regions. Users should ignore this option.

**Move/Rename**: Move this asset to another folder, or change the name of this asset. See Section 7.4.

**Copy**: Copies the current page and its contents to a specified location. See Section 7.3.

**Publish**: Used to move your pages out to your Web site. See Section 3.

**More**: Clicking this will show a drop-down menu containing more options. The most notable is “Delete” (Section 7.5) and “Versions” (Section 9), which allows a user to restore a previous version of the current page.
2. **EDIT A PAGE**

When editing a page, you can edit your content, change the name of a page, change page titles, and maintain metadata keywords and descriptions for search engines. You can create links to internal pages and external sites, insert images, create tables, and much more.

To start editing a page, click on the desired page in the left Asset Tree, and then click the **Edit** tab in the Asset Action Toolbar.

2.1. **Page Titles**

This feature gives you the ability to control the titles of a page, both what is displayed in the content area, and what is displayed in the site’s navigation.

The Display Name and Title fields are located at the top of the page when in Edit. There are two fields for maintaining this information, located in the “Inline Metadata” section:

- **Display Name**: The shortened title of your page. This is the title that is displayed in your navigation menus.  
  
  **NOTE**: If you do not want a page to be displayed in the navigational scheme, see Section 8.3 below.

- **Title**: A longer version of the display name. It is often used for the page heading and title bar of the browser. This can be the same as the Display Name field.

2.2. **The Content Editor**

The content editor integrated into Cascade Server has the same functionality and features you are most likely accustomed to using in a standard editor, such as Microsoft Word®. The advanced features of the editor are explained in the next sections. Mouse over each icon in the editor toolbar to see its description, or see a full explanation here.

To insert/edit content, simply type in your text, or paste from an external source, just as you would in a standard word processor.

2.2.1. **Helpful Tips**

- Press the “Enter” key for a double-spaced line. To make a single-spaced line, hold “Shift” while pressing Enter.

- You can open the editor in full screen mode to make it easier to edit large amounts of content. To do this, click the “Full Screen” button [ ] . To close the full screen mode, click the button again.
2.2.2. Copying & Pasting From an External Source

If you copy and paste your text from an external source (such as Microsoft Word), Cascade Server will attempt to clean up the source document’s formatting in order to display your content in your Web site’s default font.

If this does not work properly, select all text in the editor, and then click the “Remove Formatting” button . Doing so should remove any undesired formatting copied over from your source document. This will allow your site to maintain a consistent font type, size, and color.

If this step does not work, before pasting your content into the editor, click the “Paste as Plain Text” button in the toolbar, and then paste. This will bring in all of your content in plain text with no formatting. Alternatively, you can paste your content into Notepad, and then copy and paste from there.

2.3. Images

You can either insert an image that has been uploaded into Cascade Server, or point to an image that exists on another Web site. Also in this section, you can upload an image while editing the page.

**NOTES:**
- The maximum width for any image inserted into the editor is 520 pixels. There is no restriction on height.
- For best results, any image that is used in your content should be properly sized before inserting into your content area. You can upload and edit an image using Cascade Server’s image editor. See Section 7.2 below.
- For advanced image editing not covered by the Cascade Server image editor, use a graphics program before uploading the image into Cascade Server.

2.3.1. Internal

An “Internal” image is defined as an image that already resides in Cascade Server. This means that any image you want to insert into your content must first be uploaded into Cascade Server. To upload an image, see Section 7.1.1 below.

Once your image is in Cascade Server, follow the instructions below to insert the image into your content.

1. Place your mouse cursor in your content where you want the image to appear.

2. Click on the **Insert/edit Image** icon in the toolbar. A pop-up window will appear (see the screenshot to the right).

3. Select your image by doing the following:
   a. In the “Image” field, click the browse icon . Another window will open, and you will see your folder tree on the left side.
   b. Click on the appropriate folders until you find the folder which contains your image.
   c. Click on the desired image file. A preview of the image will appear to the right.
   d. Click **Confirm**. The “Image” field will be filled in with the selected image file path.
4. The “Alternate Text” field is the text that will display when a user mouses over the image (also known as the “ALT Tag”). This is also necessary for screen readers used by the visually impaired. Type in a short, meaningful description for the image. **NOTE:** This field is required.

5. **Do not enter any values for Width/Height.** We recommend resizing your image using the instructions in Section 7.2 below, and **not** using these fields.

6. There are several advanced attributes for an image. Click on the **Advanced** tab at the top of the window:

   **Alignment:** Sets the alignment of your image in relation to your content. For instance, “Default” means you can place the image anywhere on the page and it will be inline with your text. If you want the image on the right side of the page and the text to wrap around it, select “Right”. These options function the same as Microsoft Word.

   **Border Width:** Places a border around your image. 
   **NOTE:** We recommend adding a border to your image with a graphics program, and **not** using this field.

   **Vertical Spacing:** The number of pixels of padding around the top and bottom of your image. 
   **NOTE:** We recommend using a value of at least “5” for best usability practices.

   **Horizontal Spacing:** The number of pixels of padding around the left and right of your image. 
   **NOTE:** We recommend using a value of at least “5” for best usability practices.

7. Click the **Insert** button. The window will close, and your image will be inserted into the content.

8. If you need to modify your image, simply click on your image, and then click on the **Insert/edit Image** icon in the toolbar again. To move your image within the content area, click and drag the image to the desired location.

2.3.2. **External**

An “External” image is defined as an image that exists on another Web site. This means that every time someone views your Web page, the image will be called from the specified external Web site.

To link to an external image, you will need the full Web address (URL) for the image. Then do the following:

1. Place your mouse cursor in the area desired for the image within your content.

2. Click on the **Insert/edit Image** icon in the toolbar. A pop-up window will appear.

3. At the top of the popup window, select the **External** radio button.

4. In the “Image” field, type the exact Web address (URL) of the image you wish to link to. For example, [http://www.beacontechnologies.com/images/logo.gif](http://www.beacontechnologies.com/images/logo.gif). 
   **NOTE:** Ensure that your link starts with **http://**. Otherwise, the image will be broken.

5. Follow Steps 4-8 in Section 2.3.1 above.
2.3.3. Upload an Image

If your desired image is not loaded into Cascade Server, you can upload the image by doing the following from the Insert/Edit Image dialog box:

1. Follow the instructions in Steps 1-2 in Section 2.3.1 above.

2. In the “Image” field, click the browse icon. Another window will open, and you will see your folder tree on the left side.

3. In the asset tree on the left, click on the folder you wish to upload the image into.

4. Click on Upload in the top blue bar (see image to the right).

5. Click the Browse button to locate the image file on your hard drive or network drive.

6. Click Upload. Your image will be uploaded into the system and displayed.

7. Click Confirm to select the uploaded image.

8. Follow Steps 4-8 in Section 2.3.1 above.

⚠️ NOTE: You can also upload an image using Section 7.1.1 below.

2.4. Links

With Cascade Server, you have the ability to make text or an image link to a page, a file (PDF, etc.), or an external Web site. Also, you can link to a person’s email address, or add an anchor link in order to jump to a section within your page.

2.4.1. Link to Page

This section explains how to link to a page that already resides in Cascade Server.

⚠️ NOTE: To create a page, see Section 4 below.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the Insert/edit Link icon in the toolbar. A pop-up window will appear.

2. In the “Link” field, click the Browse icon. Another window will open, and you will see your Asset Tree on the left side.

3. Find the page you want to link to by clicking through the folders on the asset tree on the left, and then clicking on the desired page (will have an icon). The path to the selected page will appear on the right side of the window.
4. Click **Confirm**. The “Link” field will show the selected asset’s path.

5. Leave the value in the “Target” field set to “Same Window”.

6. Click **Insert**. The window will close, and your text (or image) will now be a link.
   
   **NOTE:** The text or image will not be clickable within the content editor.

7. If you need to modify your link, click on your link text or the image and click the **Insert/edit Link** icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the **Unlink** icon in the toolbar.

### 2.4.2. Link to File

This section explains how to link to a file within Cascade Server.

**NOTE:** To upload a file, see Section 7.1.1 below.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the **Insert/edit Link** icon in the toolbar. A pop-up window will appear.

2. In the “Link” field, click the **Browse** icon. Another window will open, and you will see your Asset Tree on the left side.

3. Find the file you want to link to by clicking through the folders on the asset tree on the left, and then clicking on the desired file (will have an icon). The path to the selected file will appear on the right side of the window.

4. Click **Confirm**. The “Link” field will show the selected asset’s path.

5. In the “Target” field, select “New Window”.

6. Click **Insert**. The window will close, and your text (or image) will now be a link.
   
   **NOTE:** The text or image will not be clickable within the content editor.

7. If you need to modify your link, click on your link text or the image and click the **Insert/edit Link** icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the **Unlink** icon in the toolbar.

### 2.4.3. Link to External Web Site

This section explains how to link to another Web site.

**NOTE:** To link to another Web site, you will need the full Web address (URL) for the site.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the **Insert/edit Link** icon in the toolbar. A pop-up window will appear.

2. Click the **External** radio button at the top of the window.
3. In the “Link” field, type in the Web address of the site you wish to link to (e.g. http://www.beacontechnologies.com/).
   \textbf{NOTE}: ensure that your link starts with \texttt{http://}. Otherwise, the link will be broken.

4. In the “Target” field, select “New Window”.

5. Click \texttt{Insert}. The window will close, and your text (or image) will now be a link.
   \textbf{NOTE}: The text or image will not be clickable within the content editor.

6. If you need to modify your link, click on your link text or the image and click the \texttt{Insert/edit Link} icon \texttt{∪} in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the \texttt{Unlink} icon \texttt{∩} in the toolbar.

2.4.4. \textbf{Link to Email Address}

This option makes your link open the user’s default mail program in order to send an email.

1. Highlight the word(s) or click on the image you wish to link to an email address, and then click the \texttt{Insert/edit Link} icon \texttt{∪} on the toolbar.

2. Click the \texttt{External} radio button at the top of the window.

3. In the “Link” field, remove the “http://” that is in the field by default. Then type “mailto:” and then the email address you wish to link to (e.g. pcs@beacontechnologies.com). The field will look like this:

   \texttt{mailto:pcs@beacontechnologies.com}

4. Click \texttt{Insert}. The window will close, and your text (or image) will now be a link that, when clicked, will send an email to the email address you entered in Step 3.
   \textbf{NOTE}: The text or image will not be clickable within the content editor.

5. If you need to modify your link, click on your link text or the image and click the \texttt{Insert/edit Link} icon \texttt{∪} in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the \texttt{Unlink} icon \texttt{∩} in the toolbar.
2.4.5. Create Anchor Links

This option allows you to link to a specified point within the current page, or on another page. For instance, if you would like to create a link that “jumps” the user down to another part of your page, you can do so by doing the following:

1. Place your cursor in the content where you wish to make the anchor point (the place where you want the user to “jump” to), and then click the Insert/edit anchor icon 📌.

2. Type the name of your anchor into the “Anchor Name” field. For example, if you are linking to a section called “History”, name your anchor “history”.
   \textbf{NOTE:} Do not put any spaces in your anchor name. Take note of the exact value you are typing in here, which will be used in a later step.

3. Click Insert. The editor places an anchor icon 📌 indicating that you have added an anchor.
   \textbf{NOTE:} This icon will not be displayed when published.

4. Highlight the text or click on the image that you wish to link to the anchor that you just created in Step 3, and then click the Insert/edit link icon 🌐.

5. If you are linking from another page to this anchor point, select the page you wish to link to in the “Link” field. If you are linking to an anchor point within the current page, skip to Step 6.

6. In the “Anchor” field, type the exact name that you used in Step 2 above.
   \textbf{NOTE:} This value must match the value from Step 2 exactly, including using the same capitalization.

7. Click Insert. The text is now the link to your anchor point.
   \textbf{NOTE:} The text or image will not be clickable within the content editor.

8. If you need to modify your link, simply click on your link text or the image and click the Insert/edit Link icon 🌐 in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the Unlink icon 🛠 in the toolbar.

2.5. Embed Media

\textbf{NOTE:} This section is for advanced users only who are familiar with embedding different types of media into a Web page and modifying an embed statement’s advanced attributes.

The “Insert/edit embedded media” icon 📡 allows you to easily add external rich media applications into your content area, such as:

- Flash (for example, .swf files or YouTube videos)
- Windows Media
- Quicktime

\textbf{NOTE:} The maximum width for any media inserted into the editor is 520 pixels.

To insert a media application:
1. Make your media file available on the Web using one of the following 2 methods:

   a. Upload the file (see Section 7.1.1 below) into Cascade Server, and then publish it to your Web site (see Section 3.1 below). Take note of the URL of your file (e.g. http://www.beacontechnologies.com/video.swf). **NOTE:** The maximum file size that can be uploaded into Cascade Server is 20 MB.

   b. Upload the file to another Web site, such as YouTube.

2. Gather the following information about your media file:

   - The full Web address (URL) of the file from Step 1 above.
   - The dimensions of the media.

3. While editing the desired page, click on the “Insert/edit embedded media” icon in the toolbar. A popup window will appear (see the screenshot to the right).

4. In the “Type” field, select the type of media for your file.

5. In the “File/URL” field, enter the full Web address (URL) for your media file from Step 2. **NOTE:** This function only allows you to embed media with an external address (e.g. http://www.beacontechnologies.com/video.swf). Therefore, the address must start with http://. Otherwise, the link will be broken.

6. Enter the dimensions of your media file into the “Dimensions” field. The first box is width, and the second box is height. **NOTE:** Each value must be in pixels. To keep the dimensions of the media proportional, check the “Constrain proportions” checkbox.

7. You should now see a preview of your media file in the “Preview” section. If not, check the accuracy of the Web address you entered in Step 5.

8. If needed, click on the “Advanced” tab at the top of the window to change any necessary values. If no changes are needed, skip to the next step.
9. Click the **Insert** button at the bottom of the window. The window will close, and a yellow box will appear in the editor where your media will be displayed (see example to the right). **NOTE:** Your media will not be displayed in the editor while editing a page. To see the embedded media, you must save your page first (see Section 2.11 below).

10. To edit the embedded media, left-click on the yellow box, and click the “**Insert/edit embedded media**” icon in the toolbar again.

### 2.6. HTML Editing

To edit the HTML for your content, click on the **HTML** icon in the toolbar. A popup window will appear containing the content’s HTML. Make the desired HTML edits, and then click the **Update** button at the bottom of the window.

### 2.7. Tables

Inserting a table into Cascade Server is very similar to Microsoft Word’s insert table wizard. **NOTE:** The maximum width for any table inserted into the editor is **520 pixels**.

1. Place your cursor in the desired location of your table and click the **Insert a new Table** icon.

2. In the “Rows” and “Cols” fields, type in the number of desired rows and columns.

3. In the “Cellpadding” and “Cellspacing” sections, type in the desired cellpadding and cellspacing. The recommended values are “3” and “0”, respectively.

4. Set the alignment of the table in the “Alignment” menu. “Not set” means you can place the table anywhere on the page, and it will be inline with your text.

5. Set the desired border thickness of your table, measured in pixels. The recommended value is 1.

6. In the “Width” and “Height” fields, type in the desired width and height of the table. This value can be in pixels or percentage (e.g. “100%”).

7. If you would like to have your table to conform to a predetermined table style, in the “Class” drop-down, select “table”. Your options are “tableTwoCol” and “tableThreeCol”. This will give your table a standard appearance that other pages use. **NOTE:** If you do select a “Class”, you must change your “Cellpadding”, “Cellspacing”, and “Border” values to “0” (zero).
2.7.1. **Advanced Options**

1. Click on the **Advanced** tab at the top of the window.

2. In the “Summary” field, type in a description of the table that you are inserting. This is required for Section 508 Compliance (if applicable). For example:
   
   This table contains donations data.

3. If you would like your table’s borders to have a color, click on the chooser icon in the “Border color” field, which will display a selection of colors to choose from. If you have a specific color you would like to use, simply enter the hexadecimal value in the “Border color” field (e.g. #336699).

   **NOTE:** If you selected a class in Section 3.5.1, #7, do not set a value for this field.

4. If you would like your table to have a background color, click on the chooser icon in the “Background color” field, which will display a selection of colors to choose from. If you have a specific color you would like to use, simply enter the hexadecimal value in the “Background color” field (e.g. #336699).

   **NOTE:** If you selected a class in Section 3.5.1, #7, do not set a value for this field.

5. Click the **Insert** button. This will close the window and display your table within your content.

6. To edit the above values at any time, right-click anywhere in the table, and select **Table Properties**.

2.7.2. **Edit Rows and Columns**

To insert or remove columns and rows, or format individual cells, columns, or rows, right-click in the desired column/row/cell to bring up the Table action menu, and select the desired action from the menu. The actions behave just like Microsoft Word and Microsoft Excel.

2.8. **Advanced Options**

The Advance Options section is located at the bottom of the page, just above the “Submit” button. If the options are not showing, click the “Advanced Options >>” link to display them. Each option is described in detail below:

- **Check Spelling:** Cascade Server will check the spelling of your content when you save the page.

- **Check Accessibility:** Enable this option if you want Cascade Server to verify that your content is accessible for disabled users. Section 508 Compliance ensures that the web content adheres to government standards for content accessibility for persons with disabilities.

- **Check Links:** Cascade Server will check the links on your page to ensure that none are broken.

- **Start Workflow:** Sends this page into a workflow. If this is disabled, you do not have a workflow available.

- **Tidy HTML:** Cleans up any HTML that you may have manually entered. This should remain checked.

- **Version Comments:** You may wish to insert comments here when editing a page. This will aid in tracking your changes for future modifications. For Versions, see Section 4 below.
2.9. Metadata

Metadata, merely data about data, is used for a variety of tasks in Cascade Server, the most common of which is dynamic navigation menus. Common navigation menus include site maps and context navigation (typically on the left navigation or top navigation). This is where you will be able to change page titles and modify keywords and descriptions used by the search engines.

1. To edit the page metadata, click on the Metadata link in the dark blue bar, just below the Asset Action Toolbar.

2. **Keywords:** Relevant keywords about your page that are read by the search engines. For more information on keywords and key phrases, please contact your Beacon Technologies Account Executive.

3. **Description:** The description that is read by the search engines. This should be a short sentence explaining the purpose of your page. For more information on Meta descriptions, please contact your Beacon Technologies Account Executive.

4. **Advanced Options:** See Section 2.8 above.

2.10. System Information

The System Information of a page is the information that Cascade Server uses to identify the page. Features include whether or not the file should be published or indexed, and spelling and Section 508 Accessibility options. The relevant options are listed below.

1. While editing your page, click the System link in the Asset Action Toolbar.

2. **Publish:** This will indicate whether your file should publish to your Web site. Uncheck this box to prevent this file from being published. There is rarely a time where you would want to uncheck this box.

3. **Index:** Tells the system whether or not to include this file in the navigation. Unchecking this box will remove this file from all navigational schemes. This is useful if you want to temporarily “turn off” a file and have it not be available to the user, but you want to keep the file in Cascade Server for later use.

4. **Advanced Options:** See Section 7 above.
2.11. Save Your Page

2.11.1. Save as Draft

The “Save as Draft” feature allows you to periodically save drafts of assets that they you editing in order to return later to finish their work. Using the “Save Draft” button will save your work, but your changes will not be committed and saved as a final version until you use the “Submit” button (Section 2.11.2 below).

To use the “Save as Draft” feature:

1. Click the **Save Draft** button, located at the bottom of your page. Your changes will be saved into a Draft mode, and the page will reload. You can now continue working on your page.

2. Once you have saved the draft version, at the bottom of the page, two new buttons will appear:
   - **Update Draft**: Use this button to save your work periodically as you make your changes.
   - **Discard Draft**: Use this button to undo all of your changes.

   **NOTE**: Using this feature will erase all changes made since the last full save of the page. This will not delete the page or any previous versions.

While your page is in Draft mode:

- You can view your changes in the page by clicking the **View** tab in the Asset Action Toolbar. To get back to editing your page, click the **Edit** tab.
- You can see the way the page looked before you started your edits. To do this, click the **View** tab in the Asset Action Toolbar. In the “Viewing” line just below the Asset Action Toolbar, click **Current**. To get back to editing your page, click the **Edit** tab.
- You can navigate away from the page and even log out, and your changes will still be saved in Draft mode for when you return.
- While other users will be able to make their own edits to the page and publish them, those users will not be able to edit or publish your current changes.
- You cannot copy, delete, or publish the page until you save the final copy using Section 2.11.2 below.

2.11.2. Save as a Final Copy

When you are completely done with your changes, you’ll then need to save your page using the **Submit** button.

1. In the “Advanced Options” section, check any desired options and enter any desired comments into the “Comments” field (see Section 2.7.1 above).

2. Click the **Submit** button at the bottom of the page. This will save your page.

**NOTES:**

- This will not publish your page to your Web site. For publishing, see Section 3 below.

- If another user has made changes to the page while you had a draft in-progress, you will receive the following message: “Another user updated the current version of this asset while you were editing.” By clicking the **Submit** button, you will overwrite the other user’s changes and save your own changes. By clicking the **Update Draft** button, you will be returned to the editing screen to make additional changes.
3. **Publishing**

One of the many benefits of Cascade Server is that you can modify your Web site within the tool, and your changes are not reflected on your live Web site until you publish your content. If you are a user with the appropriate permissions, you can publish an individual file, multiple files, an entire folder, or the entire site to your live Web site. Listed below are some general points about how publishing works:

- Publishing sends your assets from Cascade Server and moves them to the specified destination. Once you have published, it will take some time (depending on the amount of files that are publishing) to display on your live site.

- A page will publish any images that are in its content area. However, it will not publish other linked pages.

- Upon publishing, you will be taken to the publisher status screen. On this screen, you’ll see the assets that you have published and the system’s current progress, as well as any jobs currently in the queue. If you leave this screen, you can get back to it by selecting the System menu from the blue top navigation bar, then Publisher, and then clicking on **Active Jobs**.

- To see a confirmation message stating whether or not your file published successfully, click **Home** on the top navigation bar, and then select the **Messages** tab. The confirmation message will be displayed once the system has finished publishing.

3.1. **Publish a Single Asset**

To publish a single asset (page, file, or folder):

1. In the left asset tree, click on the asset (page, file, or folder) that you want to publish.

2. In the Asset Action Toolbar, select **Publish**. The screen to the right appears.

3. If you are publishing a page, you will see a “Page Configurations” section. Listed will be all available configurations of your page, such as “HTML” (your regular Web site) or “Mobile” (the mobile version of this page). Leave all of these checked in order to publish all configurations of this page. If you do not want to publish a specific configuration of this page, uncheck the appropriate checkbox.

4. In the “Destinations” section, choose which Web sites you want to publish to by checking/unchecking the appropriate destination(s).

**NOTES:**
- By default, all of your available destinations will be selected.
- For each destination (Test and Production, for example), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

5. Click **Submit**. Your asset will now publish.
3.2. Publish Multiple Assets

To publish multiple assets at one time:

1. In the navigation tree on the left, select the folder where the assets are located.
2. Check the boxes next to the assets that you want to publish.
3. At the bottom of the file list, in the "With Selected" drop-down menu, select Publish.
4. Click Submit.

⚠️ NOTE: Using this method will not allow you to select which destinations to publish to. You will automatically have to publish to all available destinations ("Test" and "Production").

3.3. Publish a Folder

Publishing a folder will publish all assets within that folder, including subfolders.

1. In the navigation tree on the left, select the folder you want to publish.
2. In the Asset Action Toolbar, select Publish.
3. In the “Destinations” section, choose which Web sites you want publish to by checking/unchecking the appropriate destination(s).

⚠️ NOTES:
- By default, all of your available destinations will be selected.
- For each destination (Test and Production), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

4. Click Submit.
3.4. Publish Your Full Site

To publish your entire Web site:

1. In the navigation tree on the left, select the "Base Folder" folder.

2. In the Asset Action Toolbar, select Publish.

3. In the “Destinations” section, choose which Web sites you want to publish to by checking/unchecking the appropriate destination(s).

⚠️ NOTES:  
- By default, all of your available destinations will be selected.  
- For each destination (Test and Production), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

4. Click Submit.

3.5. Un-publish an Asset

With Cascade Server, you have the ability to “un-publish” any asset. Un-publishing will delete an asset from your Web site, but will not remove the file from Cascade Server. To delete an asset from Cascade Server, see Section 7.5 below.

To un-publish an asset:

1. Choose the desired method of publishing above (single asset, multiple assets, or a folder), and click the Publish tab.

2. In the Asset Action Toolbar, select Publish.

3. In the “Destinations” section, choose which Web sites you want to publish to by checking/unchecking the appropriate destination(s).

⚠️ NOTES:  
- By default, all of your available destinations will be selected.  
- For each destination (Test and Production), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

4. In the “Options” section, in the “Publish Mode” section, select the “Un-publish” radio button.

5. Click Submit. The asset will now be un-published.
3.6. Publishing Guidelines

Knowing what you need to publish in order for your site to maintain its structure is critical. You can continue to have a high-quality Web site by using the guidelines listed below. Exceptions to these guidelines for your specific Web site will be covered with you by a Beacon representative.

The below table highlights common changes you will make, and what publishing action you should take.

<table>
<thead>
<tr>
<th>Asset Action</th>
<th>Explanation</th>
<th>Publishing Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Changes to a Page</td>
<td>The changes you made only affect the current page.</td>
<td>Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td>Add a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Folder (Section 3.3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Full Site (Section 4)</td>
</tr>
<tr>
<td>Rename a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Folder (Section 3.3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Full Site (Section 4)</td>
</tr>
<tr>
<td>Move a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Folder (Section 3.3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Full Site (Section 4)</td>
</tr>
<tr>
<td>Delete a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Folder (Section 3.3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Full Site (Section 4)</td>
</tr>
<tr>
<td>Change a Page’s Display Name</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Folder (Section 3.3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Full Site (Section 4)</td>
</tr>
<tr>
<td>Change a Page’s Title</td>
<td>The changes you made only affect the current page.</td>
<td>Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td>Change a Page’s Metadata</td>
<td>The changes you made only affect the current page.</td>
<td>Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td>(keywords and description)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sort Assets</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Folder (Section 3.3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Full Site (Section 4)</td>
</tr>
<tr>
<td>Upload File(s)</td>
<td>The changes you made only affect the current file(s).</td>
<td>Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Publish Multiple Assets (Section 5)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Publish Folder (Section 3.3)</td>
</tr>
</tbody>
</table>
4. **CREATE A PAGE**

Creating a new page in Cascade Server is simple. When you add a new page to a main folder (i.e. a folder that is listed as a main category on your Web site), the navigational structure of your site will be automatically updated with the information you provide.

To add a new page:

1. In the left asset tree, click on the folder that you wish to add a new page to.

2. In the blue Top Navigation Menu bar, click **New**, and then click the type of page you wish to add (e.g. “Standard Page”).

3. In the “System Name” field, replace the value with the desired file name of your new page.

**NOTES:**
- Do **not** add a file extension (e.g. “.aspx”). For example, if you are adding a file called “default.aspx”, you will want to just type in “default”.
- Do **not** put spaces in your file name. Instead of spaces, use hyphens.
- Use all lowercase letters.
- The “System Name” value should be short, and is not the page’s title.

4. Verify that the folder listed in the “Parent Folder” (the folder that the page will be created in) field is correct. If it needs to be changed, click on the path and select the correct folder.

5. Click the **Metadata** link in the Asset Action Toolbar and type in any keywords or descriptions that you want (optional).

6. Click the **Content** link in the Asset Action Toolbar.

7. Type in the desired values for the “Display Name” and “Title” for the page. The “Display Name” is the value that will be displayed in your site’s navigation, and the “Title” is the value that will be displayed as the page’s title above your content area.

8. Insert your content into the editor by following the steps listed in Section 2.2 above.

9. Follow the instructions in Section 8 below to sort your new page in the navigation (if applicable), and publish your page using the instructions in Section 3 above.
5. **CREATE A SUBSECTION**

In addition to creating pages within a main section (e.g. “About Us”, “Our Products”, etc.), you may find it necessary to create a subsection within that section. This is useful for housing a related group of pages in one section, making it easier for a site user to navigate your pages. The new subsection will display on the top and left navigation, and the left navigation will expand to show your subsection’s pages.

For example, you want to add a subsection called “Our History” to your main section “About Us”, resulting in “About Us > Our History”. To do this:

1. Navigate to the folder that you wish to add the new subsection to.

2. In the blue Top Navigation Menu bar, click **New**, and then click **Folder**.

3. In the “System Name” field, type in the name of your new folder.

   **NOTES:**
   - Do not put spaces in your folder name. Instead of spaces, use hyphens.
   - Use all lowercase letters.

4. Type in a “Display Name” and “Title” for your folder. The “Display Name” will be the value that will be displayed in the navigational structure, and the “Title” will be displayed on your page as subsection’s main title.

5. Click **Submit** to save your new folder.

6. In this new folder, follow the steps in Section 4 above to create your new pages, and sort your pages as desired (see Section 8.2 below for sorting instructions). **NOTE:** The first (main) page of your subsection must be named “default” for your navigation to work properly.

7. Click on the subsection’s parent folder (the folder you created in Step 5) in the left asset tree. The parent folder is the main section’s folder (in this case, “about”).

8. Sort your new subsection as desired (see Section 8.2 below for sorting instructions).
6. FOLDERS

6.1. Detail View

The folder detail view can be seen by clicking on the desired folder in the left asset tree (see the screenshot to the right for an example). The detail view shows all assets in that folder using the following columns:

- **Name**: The asset’s file name.
- **Order**: The order that these assets will appear in the navigation. See Section 7 below.
- **Last Modified**: The date that the asset was last modified.
- **Last Modified By**: The user who last modified the asset.
- **Actions**: Sorting and editing options. This column can be ignored.

6.2. Add a Folder

You can add a folder to any part of your Web site to organize images, PDF documents, etc.

⚠️ NOTE: To add a folder for the purposes of sorting your navigation, please see Section 5 above to add a subsection.

To add a folder:

1. Select the desired folder in the asset tree on the left that you want to add this new folder into, and then click New, and then click Folder.
2. Type in the desired folder name into the “System Name” field.
3. Click Submit. The folder will be created.

6.3. Edit a Folder

You can edit any folder name or title within a major section. For example, you can edit any folder under the “about-us” folder, but not the “about-us” folder itself. Editing a folder would include changing the folder name, Display Name, Title, or the parent folder.

1. Select the desired folder in the asset tree on the left, and then click “Edit”.
2. Make the desired changes to the Display Name, Title, and System Name, and then click Submit.
7. **Asset (File) Management**

An asset in Cascade Server is any file within the system: a page, an image, a folder, etc. This section covers the kinds of actions you can perform with these assets, including uploading files, modifying files, using the image editor, and copying, moving, renaming, and deleting assets.

7.1. **Files**

In order to use any files in your content, you will first need to upload them into Cascade Server. You can upload any file type to Cascade Server. You can upload one file at a time, multiple files at once, or edit an existing file.

7.1.1. **Upload a Single File**

1. In the left asset tree, click on the folder that you want to upload your file to.

2. In the top navigation bar, click **New**, and then click **File**.

3. Leave the “System Name” field blank. The system will automatically use the name of the file being uploaded.

4. In the “Data” section, click the **Browse** (or **Choose File** in Chrome) button. A popup window will be displayed, which shows the contents of your hard drive or network drive.

5. Find the file that you want to upload and click on it. Then click the **Open** in the bottom right-hand corner of the window. The window will close.

6. If you are uploading an image, the image will be displayed inside of an image editor. To use the image editor, see Section 7.2 below. If you are uploading anything other than an image, you will not see a preview of the file.

7. Click the **Submit** button at the bottom of the page. The page will reload with your uploaded file, placed into the folder you selected in Step 1. A preview of the file will be displayed on the right.

⚠️ **NOTES:**

- The maximum file size that can be uploaded into Cascade Server is **20 MB**.
- While pages should not have an extension on its System Name value, files must keep their native file extension (e.g. “.pdf”). Do not remove these extensions from a file’s System Name value.
7.1.2.  Upload Multiple Files

If you have multiple files that you would like to upload, you can upload them all at once to save you time. Doing so requires the use of a ZIP program, such as the ZIP program included in Microsoft Windows. You can zip all of your files and directory structure into a single file, upload this file, and Cascade Server will extract your files with the directory structure into your destination folder.

1. Using your ZIP program, zip up all of the files you want to upload. Your file must have a .zip extension.
2. Navigate to the folder that you want to upload your ZIP file to.
3. In the blue top navigation bar, click Tools, and then click Zip Archive.
4. In the “Zip Archive” field, click the Browse button. Locate your ZIP file on your hard drive.
5. Click Submit. Your ZIP file will be uploaded, and its contents extracted into your placement folder.

7.1.3.  Update a File

Updating a file that is already in the system requires uploading a new version of the file. To update a file that you have already uploaded:

1. In the left asset tree, select the file you wish to update, and then click Edit.
2. Click the Browse button in the “Upload” section and select the file from your hard drive.
3. Click Submit. The file you selected in the system will be overwritten with the file selected.

7.2.  Edit an Image

The image editor allows basic image manipulation operations without requiring any additional software. Once you have uploaded an image into Cascade Server, you can perform edits to that image. Specifics about the image editor are listed below:

| Available Actions                      | • Resize dimensions (maintaining aspect ratio or not)  
|                                       | • Rotate clockwise/counterclockwise  
|                                       | • Flip horizontal/vertical  
|                                       | • Crop  
|                                       | • Undo/Redo  
| Applicable File Types                 | • .jpg  
|                                       | • .jpeg  
|                                       | • .png  
|                                       | • .bmp  
|                                       | • .gif  
| Supported Web Browsers                | • Microsoft Internet Explorer 7+  
|                                       | • Mozilla Firefox 3.5+  
|                                       | • Google Chrome 10+  

Below are instructions for using the image editor.
1. Begin editing the image by performing one of the following actions below:

a) **Upload a New Image and Edit**  
   If you want to edit an image when uploading it into Cascade Server for the first time, follow the instructions in Section 7.1.1 above, Steps 1-5 to upload your image. After performing these steps, the image editor will be displayed (see the screenshot to the right).

b) **Edit an Existing Image**  
   If you want to edit an image that already has been uploaded into Cascade Server, navigate to the image you want to edit, and click the *Edit* tab. The image editor will be displayed (see the screenshot to the right).

2. In the image editor, perform the desired action. Each available editing action is listed in detail below:

   **Undo/Redo**  
   These actions work the same way as other programs. The “Undo” action is only available after performing one of the below actions. The “Redo” action is only available after an “Undo” action is performed.

   **Resizing**  
   a) Change the width and the height values to resize the image. When you change either of these values, the other value will change proportionally to keep the proper aspect ratio. To disable this feature in order to change each value independently, click the “link” icon in between the two boxes.
   b) Click the “Resize” button (to the right of the “Height” box) to apply your changes.

   **Rotate**  
   Change the orientation of the image clockwise or counterclockwise.

   **Flip**  
   Flip the image like a mirror, vertically or horizontally.

   **Crop**  
   Remove unwanted parts of the image.
   a) Place your mouse cursor inside of the image, and click and drag to select the area of the image you want to keep. The selected area will be highlighted (see the screenshot to the right). To change the size of the selection, use the box “handles” to drag the selection.
   b) Click the “Crop” button (red arrow in the screenshot to the right).

3. Click the **Submit** button at the bottom of the page to save your changes.

4. **Publish** your updated image. See Section 3.1 above for instructions.
7.3. Copy Assets

7.3.1. Copy a Single Asset
1. While viewing the asset, click the Copy tab.
2. Change the file name (in the “System Name” field) if desired.
3. Select the parent (destination) folder, and then click Submit.

7.3.2. Copy Multiple Assets
1. Select the folder containing the assets you want to copy. A detailed list of those assets will be displayed.
2. Select the assets you want to copy by checking the boxes of those assets.
3. In the “With Selected” drop-down menu, select Copy.
4. Select the parent (destination) folder, and then click Submit.

7.3.3. Publishing After Copying Assets
After copying your assets, you must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

7.4. Move Assets
Before moving an asset, it’s a good practice to remove the asset from your Web site first to ensure that the old asset no longer exists. To move a page, file, or folder to another location within Cascade Server:

7.4.1. Move a Single Asset
1. Un-publish the asset first. See Section 3.5 above for instructions.
2. Once the asset has been Un-published, while viewing the asset, click the Move/Rename tab.
3. Change the file name (in the “System Name” field) if desired.
4. Select the parent (destination) folder, and then click Submit.

7.4.2. Move Multiple Assets
1. Un-publish the asset first. See Section 3.5 above for instructions.
2. Select the folder containing the assets you want to move. A detailed list of those assets will be displayed.
3. Select the assets you want to move by checking the boxes of those assets.
4. In the “With Selected” drop-down menu, select Move.
5. Select the parent (destination) folder, and then click Submit.
7.4.3. Publishing After Moving Assets

After moving your assets, you must publish any pages containing navigation affected by the change. You must also publish any pages that are linked to those assets. For publishing instructions, see Section 3 above.

To determine if any of the pages you just moved are linked to from another page, do the following:

1. Select the desired page, and click the More tab, and then Delete.

2. If the “Relationships” group appears (see the screenshot to the right), and then you have other pages that are linked to this page. Take note of the pages in the “Relationships” list.

3. Click the Cancel button to stop deleting the page.

   **NOTE:** Do not click the Submit button. If you do, this asset will be deleted.

4. Publish each one of those pages you took note of in Step #2.

7.5. Delete Assets

In order to properly delete an asset, follow these instructions:

7.5.1. Delete a Single Asset

The first step will be to delete the asset from Cascade Server while removing the asset from your published Web site. Then, you will need to publish any affected assets (if applicable).

1. While viewing the asset, and then click the More tab, and then Delete.

2. In the “Un-publish” section, check the box next to “Un-publish Content”. See the red circled area in the example to the right.

3. If the asset you are attempting to delete is linked to from other assets within Cascade Server, the “Relationships” section will appear. This section informs you that the listed assets contain links that will be broken once you delete the current page, and will need to be fixed. Once you have completed deleting this page, you will need to go to the listed assets and fix the broken links.

4. Click Submit. The asset will be deleted from Cascade Server and from your Web site.
7.5.2. **Delete Multiple Assets**

1. Select the folder containing the assets you want to delete. A detailed list of those assets will be displayed.

2. Select the assets you want to delete by checking the boxes of those assets.

3. In the “With Selected” drop-down menu, select Delete.

4. In the “Un-publish” section, check the box next to “Un-publish Content”.

5. Click **Submit**. The asset will be deleted from Cascade Server and from your Web site.

7.5.3. **Publishing After Deleting Assets**

After deleting your assets, you must publish any pages containing navigation affected by the change. You must also publish any pages that are linked to those assets. For publishing instructions, see Section 3 above.

7.5.4. **Recover Deleted Assets**

When you delete any asset, it will be stored in the Recycle Bin. See Section 10 below for more details.

7.6. **Rename an Asset**

To change the file name of a page, file, or folder, do the following:

1. While viewing the asset, click the **Move/Rename** tab.

2. Change the “System Name” field to the desired file name. **NOTE:** If you are renaming a page, do not add an extension (i.e. “.aspx”). If you are renaming a file, you must keep the extension (“.pdf”, “.gif”, “.jpg”, etc.).

7.6.1. **Publishing After Renaming Assets**

After renaming your assets, you must publish any pages containing navigation affected by the change. You must also publish any pages that are linked to those assets. For publishing instructions, see Section 3 above.

To determine if any of the **pages** you just renamed are linked to from another page, do the following:

1. Select the desired page, and click the **More** tab, and then **Delete**.

2. If the “Relationships” group appears (see the screenshot to the right), and then you have other pages that are linked to this page. Take note of the pages in the “Relationships” list.

3. Click the **Cancel** button to stop deleting the page. **NOTE:** Do not click the **Submit** button. If you do, this asset will be deleted.

4. Publish each one of those pages you took note of in Step #2.
7.7. **Deactivate / Activate an Asset**

In some cases, you will want to temporarily remove a page from your site’s navigational structure, or deactivate a file, enabling them to be available to be reactivated later. You will need to un-publish the page, and then turn it off. When you are ready to reactivate it, you will need to turn it back on. To do this:

1. Navigate to the asset that you wish to deactivate/activate, and then click the **Edit** button.

2. Follow the instructions in Section 3.5 above to un-publish the asset.

3. Click on the **System** link in the dark blue bar just below the “Edit” tab.

4. Uncheck the boxes for “Include when Publishing” and “Include when Indexing”. This will prevent the asset from being published, and remove all navigational items (if applicable), leaving your asset in Cascade Server for later use.

5. Click the **Submit** button to save your page.

6. You must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

7. **To activate the asset:** Follow the steps above and check the “Include when Publishing” and “Include when Indexing” checkboxes in Step 4. You must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

8. **MANAGE NAVIGATION AREAS**

The navigation areas of your Web site are automatically built by Cascade Server, but there are several actions you can take to manipulate these areas.

8.1. **Add a Link**

A “Link” in Cascade Server is a way to add an item to your navigation that links the user to another section in your current site, or to an external Web site. For example, say you wanted to link a user to the “Contact Us” section from the “Customer Center” section of your site.

To accomplish this, you would add a link called “Contact Us” into the “Customer Center” folder, which links to the “Contact Us” section. This link would then be displayed in your navigation. When the user clicks on “Contact Us” in the left navigation of “Customer Center”, they will be taken out directly to the “Customer Center” section. Likewise, you can add a link into your navigation that links to an external Web site.

To add a link to another asset within your site, or to add a link to an external Web site, follow the instructions below.
To add a link to your navigation:

1. In the Asset Tree on the left, navigate to the folder you wish to add the link to.

2. In the top blue navigation bar, click on **New**, and then click **Navigation Link**.

3. Type in a Display Name for your link. Remember, the Display Name will be displayed in the navigation.

4. Scroll down to find the “Navigation Link” section, then choose **one** of the options below:

   **To Link to a Page in Cascade Server:**

   a) In the “Link to Page” section, click on the browse icon in the “Select Page” field. Another window will open, and you will see your Asset Tree on the left side.

   b) Find the page you would like to link to by selecting folders on the asset tree on the left, and clicking on the asset.

   c) Click **Confirm**. The window will close, and the “Select Page” field will show the selected page’s path.

   d) Proceed to Step 5 below.

   **To Link to a File in Cascade Server:**

   a) In the “OR Link to File” section, click on the browse icon in the “Select File field. Another window will open, and you will see your Asset Tree on the left side.

   b) Find the file you would like to link to by selecting folders on the asset tree on the left, and clicking on the asset.

   c) Click **Confirm**. The window will close, and the “Select File” field will show the selected file’s path.

   d) Proceed to Step 5 below.

   **To Link to an External Web Site:**

   a) In the “OR Link to External Web Site” section, type in the Web address (URL) of the site you wish to link to (e.g. **http://www.beacontechnologies.com/**). into the “URL” field.  

   ▲ **NOTE:** Ensure that your link starts with **http://**. Otherwise, the link will be broken.

   b) By default, this link will open in a new browser window. If you do not want it to open in a new window, select **Same Window** in the “Target” field.

   c) Proceed to Step 5 below.

5. Click **Submit** to save the link. Follow the instructions in Section 8.2 below to sort your new link in the navigation, and Section 3 to publish your new link.
8.2.  Sort

The links in the navigation areas can be sorted easily. While looking at a folder’s detail view (Section 6.1 above), you can click on the “Order” column to display the sort order for that folder’s assets. To sort how your assets appear in your site’s navigation:

1. Click on the desired folder in the left asset tree containing the assets you want to sort.
2. If your assets are not listed in ascending order in the “Order” column, click the “Order” column heading.
3. Place your mouse anywhere on the line of the asset you wish to move. Your mouse pointer will change to ↑. (If your mouse pointer does not change, move horizontally along the asset’s line until it does).
4. Click and hold your left mouse button, and then drag the asset up and down to the desired position.
5. Release your left mouse button. The sort order will change automatically.
6. After sorting your assets, you must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

8.3.  Remove a Link

It is possible to have a page on your site that is not listed in your navigational menus. This is useful if you have a page that you just want to link to, but don’t necessarily want listed in your left navigation menu or your top navigation drop-down menus. To accomplish this:

1. Go into Edit mode for the page you wish to remove from your site’s navigational menus.
2. Remove the “Display Name” in the “Inline Metadata” field. You will need to keep the “Title” value as-is.
3. Click Submit.
4. You must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.
9. **Versions**

Cascade Server keeps the last **unlimited number of** versions of your assets, allowing you to restore a previous version of your page. This is especially useful if you make several modifications and need to back them out.

⚠️ **NOTE:** Any asset (except folders) can be rolled back to a previous version.

9.1. **Restore Previous Version**

To preview and restore a previous version of an asset:

1. Navigate to the asset that you wish to change the version for.

2. In the Asset Action Toolbar, click the “More” tab, and then click **Versions**. This will bring up a list of all available versions of your asset. Listed is the path of the asset, the date of the version, who modified it, and any comments that the user entered.

3. Choose the asset version you wish to restore by clicking the asset’s path in the “Path” column.

4. Cascade Server displays the selected version, along with a list of options called “Viewing”. You can perform the following actions with these options:

   - **Newer:** Displays the next newer version of the selected asset.
   - **Older:** Displays the next oldest version of the selected asset.
   - **Current:** Displays the current version of the asset.
   - **Activate:** Selecting this option will make the selected version the current version. By doing so, the previous current version will become the next-latest version.
   - **Delete:** If you are certain that the selected version will never be needed, you can select this option to remove it. See Section 9.2 below for more information.
   - **Compare with Current:** Allows you to merge the current version and the selected version together, displaying what the differences are between the two versions. This is similar to Microsoft Word’s “Track Changes” function. ⚠️ **NOTE:** This works for pages only.

5. Once you choose the version you want to restore, select **Activate**. The selected version will be implemented.

6. **Publish** the asset. See Section 3 above for instructions.

9.2. **Delete Versions**

You have the ability to delete unwanted versions in order to keep the number of versions below unlimited number of. To do this:

1. Select the asset in which you wish to delete the previous versions.

2. In the Asset Action Toolbar, click the **Versions** tab. This will bring up a list of all available versions of your asset. Next to each previous version is a checkbox.

3. Check each version that you wish to delete.
4. At the bottom of the page, in the “With Selected” drop-down box, select “Delete”.
10. **Recycle Bin**

Cascade Server's Recycle Bin is a temporary holding area for deleted assets which helps prevent loss of content. Assets in the Recycle Bin can be restored to their original location. For instructions on deleting assets, see Section 7.5 above.

**How long do deleted assets stay in the Recycle Bin?**

Assets that are deleted will remain in the Recycle Bin for 30 days, and then be permanently deleted.

**What is sent to the Recycle Bin?**

All assets (pages, files, folders) are sent to the Recycle Bin when deleted. Once in the Recycle Bin, the assets can be restored to their original location (see below), or they will be permanently deleted after 30 days.

**Accessing the Recycle Bin**

To access the Recycle Bin, click the link on the Dashboard or the link in Quick Links. See the screenshot to the right.

**Restoring Assets**

To restore an individual asset back to its original location, click the green Restore icon in the Actions column. See the screenshot to the right.

To restore multiple assets, select the assets using the checkboxes in the left column. Then click the "With Selected:" dropdown menu, and select Restore.
11. **USABILITY GUIDELINES**

When editing your own content, maintaining a consistent look and feel across all pages is vital for your site’s visitors. Here are some guidelines for good usability practices.

- **Use consistent font types.** If your site uses an Arial font, you should only use Arial in your content.

- **Use consistent colors.** Try to keep any colors consistent with your site’s color scheme.

- **Resize your images using a graphics program.** Don’t put large images in your content. You will want to scale them down as to not overwhelm the user and push your text to the bottom of the page.

- **Don’t overuse bolding, italics, or capitalization.** Bolding, italics, and capitalization are both used for emphasizing a word or a sentence. Bolding or italicizing an entire paragraph or page, or capitalizing a headline or title, can detract from the look of your content and make it difficult to read.

- **Use consistent font sizes.** Try not to use very large font sizes. Use the same font size for a heading that is used on another page in order to keep a consistent look.

- **Format bullets or numbered lists.** Always left-align bulleted or numbered lists. Centering these can confuse the user and make it hard for them to read down the list.

- **Always left-align paragraphs.** For a paragraph of text, you will always want to left-align the text. Centering or right-aligning will make the text more difficult to read.

- **Right-align labels.** If you are creating a label followed by a colon, right-align the labels and bold them. For example:

  - **Your Name:** Joe Smith

- **Keep it professional.** Use the same standards that you would use when creating a document in a word processor.
12. NEWS

The News section is a central repository of all press releases, no matter what date or category the press release is tagged with. Various listing pages throughout the News section will extract events that meet specified criteria.

The location of the News section is:

/news/

This folder contains the following folders and pages:

- **press-releases (folder):** Regardless of category, all press releases will be stored in this folder. See Section 2.1 for more information.

- **default (page):** Contains the most recent 3 press releases sorted by date newest to oldest, the most recent 3 articles from U of H in the News newsfeed, media contacts section and expert advice section. See Section 2.4 for more information.

- **in-the-news-archive (page):** Lists all the articles in the U of H in the News newsfeed sorted with the most recent first. This page also displays the media contacts, and expert advice sections. See Section 2.3 for more information.

- **press-release-archive (page):** Lists all press releases from the site sorted with the most recent first. This page also displays the media contacts, and expert advice sections. See Section 2.2 for more information.

12.1. Add a Press Release

Regardless of the press releases’ category, you will be adding all events into the following folder:

/news/press-releases/

Within this folder are folder years in order to help you keep the press releases organized. To add a press release:

1. From the “New” menu, select **News > Press Release**.

2. Change the System Name value to the desired file name. **NOTE:** it is recommended that there be no spaces in this name. Instead, use hyphens (i.e. “u-of-h-awarded-grant”).

3. Change the Parent Folder to the correct year/month. For example if you are creating a press release for December of 2009, you would change the parent folder to /news/press-releases/2009/12. Note this is only to keep the press releases organized and has no effect on listing pages.

4. Type the title into the “Title” field (REQUIRED), and type the author name into the “Author” field (REQUIRED).

5. Select the category for the press release from the “Category” drop down (REQUIRED). **NOTE:** This field will be used for future functionality and is not currently used on any listing or detail page.
6. Select the date of the press release (REQUIRED).
   - **IMPORTANT:** To enter a date, you must use the calendar function by clicking on the calendar icon . Entering an incorrectly-formatted date will cause the press release to not display on any listing page.
   - Note the time fields are not used and do not display on any listing or detail page.

7. Type the summary text into the “Summary” field. This will be displayed on listing pages only.

8. Type the content of the press release into the “Article Content” field.

9. Type the press release contact name, phone number, and email address (REQUIRED).

10. Click the Submit button to save the press release.

11. Publish the added news page. The article will be displayed on all applicable listing pages within the next hour.

12.2. **Press Release Archive**

The Press Release Archive view (/news/press-release-archive) is automatically populated with press releases from the central press release repository, and cannot be modified by editing this page. The press releases are automatically updated using the criteria below:

- This page displays all press releases, regardless of date or category.
- There is no minimum or maximum number of press releases that will display on this page.

12.3. **U of H In the News Archive**

The U of H In the News Archive view (/news/in-the-news-archive) is automatically populated with data from an RSS feed (http://www.hartford.edu/daily/rss_inthenews.asp), and cannot be modified by editing this page. The news articles are automatically updated using the criteria below:

- This page displays all news articles from the RSS feed, sorted by date newest to oldest.
- There is no minimum or maximum number of news articles that will display on this page.
12.4. News Landing Page

The news section landing page (/news/default) contains the most recent three press releases sorted by date newest to oldest, the most recent 3 articles from U of H in the News newsfeed, media contacts section and expert advice section.

The news listings on this page are automatically populated with data from the press releases and the RSS feed and cannot be modified by editing this page. The news articles are automatically updated using the criteria below:

- This page displays the most recent three press releases, sorted by date newest to oldest.
- This page displays the most recent three news articles from the RSS feed, sorted by date newest to oldest.

This page is where you will edit the Media Contacts and Expert Advice sections. See Sections 2.5 and Section 2.6 for more information.

12.5. Media Contacts

The Media Contacts are maintained on one page (/news/default), and displayed throughout the news section. You can add as many Media Contacts as you’d like. To maintain the Media Contacts:

1. Edit the News section landing page (/news/default), then find the Media Contact group.

2. Type the name into the “Name” field (REQUIRED).

3. Type the title into the “Title” field (REQUIRED).

4. Type the contacts phone number into the “Contact Phone 1” field (REQUIRED).

5. Type an additional phone number for the contact into the “Contact Phone 2” field (OPTIONAL).

6. In the “Image” field, select the image you’d like to display (REQUIRED). Note that the required dimensions are 83 pixels x 73 pixels.

7. Type in the ALT text for the image (REQUIRED).

8. **To Add a Contact:** Find the “Media Contact” section that you want to add the new media contact AFTER, then click the icon. Then follow Steps 2-7 above.

9. **To Delete a Contact:** Find the media contact you want to remove, and click the icon.

10. **To Sort the Contacts:** Find the media contact you want to move up or down in the list, then click the or icon.

11. **To Publish:** In order to update the Media Contacts, you must publish the entire /news/ directory (in order to publish all pages in the News section).

12. Click the Submit button.
12.6. Expert Advice

The Expert Advice section is maintained and displayed on one page (/news/default). Note that there is a limit of three experts that can be displayed in the box. To maintain the experts:

1. Edit the News section landing page (/news/default), then find the Expert Advice group.

2. Type the name into the “Name” field (REQUIRED).

3. Type the description into the “Description” field (REQUIRED).

4. In the “Image” field, select the image you’d like to display (REQUIRED). Note that the required dimensions are 100 pixels x 150 pixels.

5. Type in the ALT text for the image (REQUIRED).

6. You can link the expert one of three ways:
   - Link to a page within Cascade Server;
   - Link to a file (PDF, etc.) that has been uploaded into Cascade Server;
   - Link to an external Web site. Note that you must enter the entire URL of the Web site (i.e. http://www.beacontechnologies.com/). NOTE: Failure to insert the http:// will result in the link being broken. If using an external Web site, select whether the link should open a new window or not.

7. To Add an Expert: Find the “Expert Advice >> Article” section that you want to add the new expert AFTER, then click the icon. Then follow Steps 2-6 above. NOTE: There is a limit of three experts to be displayed.

8. To Delete an Expert: Find the expert you want to remove, and click the icon.

9. To Sort the Experts: Find the expert you want to move up or down in the list, then click the or icon.

10. To Publish: In order to update the experts, you need to publish the News landing page (/news/default).

12.7. Adding a Press Release Year

In the press release repository, a folder structure has been created to allow the user to organize the press releases by year and by month. This folder structure is as follows:

press-releases
    2009
        1
        2
        ...
        12
Currently, 2009 and 2010 exist. To create a new year folder:

1. In the New menu, select **News > Press Release Year**.
2. Change the System Name field value to the desired year (i.e. “2011”).
3. Click the **Submit** button to save. The new year’s folder structure will be created in the following folder: `/news/press-releases`
4. You may start adding press releases to the new folder structure.

### 12.8. Maintaining Categories

Cascade Server users who have the ability to access the Administration section can maintain the list of categories.

- The category listing is kept in Metadata Sets in order to be available on all necessary pages (FUTURE).
- An unlimited number of categories can be added.
- When adding a category, it will be immediately available on all press release category select boxes.
- **NOTE:** If you remove a category, any press release that is attached to that category will be detached, and will not contain any category. When a category is removed from the list, a press release will not automatically select another category.

To maintain the list of categories for Press Releases:

1. In the Administration section, select **Metadata Sets**, then edit the **Press Release** Metadata Set.
2. Click **Dynamic Fields** in the blue bar below the tabs.
3. Find the “Dynamic Field” group that contains the “Name” of “category”. **NOTE:** Do not change the “Name” value. Doing so will erase all press releases’ selected categories.
4. In the “Configuration” field, in the desired location in the list, enter the following EXACTLY as it appears below:

   ```html
   <item>Category Name Here</item>
   ```
   
   (NOTE: You cannot use “&” in the name of the category.)
5. To delete a category, remove the above line completely.
6. Once you are done adding and removing categories, click the **Submit** button to save.
12.9. Publishing

In order to maintain timely news across the site, all news listing pages are scheduled to publish once an hour on the hour, using a Publish Set.

To modify this Publish Set, go to the Administration section, and then select Publish Sets, then select News Listing Pages.

A few notes to keep in mind:

- Because Cascade Server publishes one job at a time, it is possible that this hourly publish job will be in the queue behind one or multiple publishing jobs executed by other Cascade Users. Therefore, the news items would not be published out exactly on the hour. The news items will publish as soon as the job becomes the current publish job.

- An article will NOT be displayed on any listing pages until the article detail page has been published.

13. My Story Archive

The My Story Archive contains a listing of stories that used to be on the homepage, and the listing allows a user to view the details of the story. The location of the My Story Archive section is:

/stories/

- default (page): Lists all stories, sorted by the folder order of the stories. See Section 3.2 for more information.

13.1. Add a Story

You will be adding all events into the following folder:

/stories

To add a story:

1. Upload the desired video for the story to Amazon S3, and take note of the video’s file name.
   
   **NOTE:**
   - The video file must be a “MP4” file with a “.mp4” extension in order to work properly.
   - The video file must be uploaded to the above folder.

2. From the “New” menu, select My Story Archive.

3. Change the System Name value to the desired file name. **NOTE:** it is recommended that there be no spaces in this name. Instead, use hyphens (i.e. “joe-smith”).
4. By default, this story will be displayed on the homepage. If you do not want this story displayed on the homepage, in the “Display on Homepage?” field, select “No”.

5. Type the story title into the “Story Title” field (REQUIRED).

6. Type the story subject’s name into the “Name” field (REQUIRED).

7. Type a title into the “Title” field (OPTIONAL).

8. Enter the body of the story into the “Content” WYSIWYG field.

9. In the “Main Photo” field, select the image you’d like to display (REQUIRED). Note that the required dimensions are 124 pixels x 106 pixels. This photo will be displayed in the following places:
   - Homepage: Thumbnail image in the right column of the large “My Story” area
   - My Story Listing Page: Left column
   - My Story Page: Heading

10. In the “Homepage Photo” field, select the image you’d like to display on the homepage as the featured story (REQUIRED if you selected “Yes” in Step #4 above). Note that the required dimensions are 620 pixels x 415 pixels.

11. If there is an informational link then enter the link text you’d like to appear into the “Link Text” field. You can link one of three ways:
   - Link to a page within Cascade Server;
   - Link to a file (PDF, etc.) that has been uploaded into Cascade Server. **NOTE:** To link to a video, use the field below;
   - MP4 Video: To add a video to the story, in the “OR Amazon S3 MP4” field, enter the file name of the video you uploaded in Step #1 above. **NOTE:** Do not enter the video’s path or file extension into this field. For example, if your video file name is “JoeSmith.mp4”, you will only need to enter “JoeSmith” into this field.
   - Link to an external Web site. Note that you must enter the entire URL of the Web site (i.e. http://www.beacontechnologies.com/). **NOTE:** Failure to insert the http:// will result in the link being broken. If using an external Web site, select whether the link should open a new window or not.

11. **To Sort the Stories:** Select the /stories/ folder in the left asset tree, and sort the pages.

12. Click the **Submit** button to save the story.

**13.2. Publishing**

In order to publish a new story, you must publish the following assets:

- My Story Archive listing page: /stories/default
- The story page that you created.
14. **RIGHT COLUMN CONTENT**

The right column of standard pages have been modified to allow a user to select which content blocks they’d like to display on a page-by-page basis. The user can select content from a central repository, allowing re-use of content across multiple sections.

All right column content is kept in the following location:

/right-column/

You can organize the content in any way that you want. We have started off by creating a few folders for organizational purposes only.

Each page in these folders is called into the main site page’s right column as an include file. Therefore, if updates are made to the right column content, only that asset needs to be published.

You can create as many callout blocks as you’d like, and you can re-use a callout block as many times as you want.

14.1. **Create a Callout Block**

The right column callout block will allow the user to create a callout box, select the background color, and populate the content. To create a right column callout block:

1. From the “New” menu, select **Right Column > Callout Block**.

2. Change the System Name value to the desired file name. **NOTE:** it is recommended that there be no spaces in this name. Instead, use hyphens (i.e. “joe-smith”). Also, select the Parent Folder you want to save the block into.

3. Choose the desired background color (REQUIRED).

4. Type in the desired title that will appear at the top of the box (REQUIRED).

5. Select the desired image. Note the required image sizes, which vary with the orientation (vertical or horizontal) or your image (REQUIRED).

6. Type in the desired content into the “Content” area (REQUIRED).

7. You can optionally link the callout in one of three ways:
   - Link to a page within Cascade Server;
   - Link to a file (PDF, etc.) that has been uploaded into Cascade Server;
   - Link to an external Web site. Note that you must enter the entire URL of the Web site (i.e. [http://www.beacontechnologies.com/](http://www.beacontechnologies.com/)). **NOTE:** Failure to insert the http:// will result in the link being broken. If using an external Web site, select whether the link should open a new window or not.

8. Click the **Submit** button to save the callout.
14.2. Create a Link List
The right column link list will allow the user to create a list of links. To create a right column link list:

1. From the “New” menu, select Right Column > Link.

2. Change the System Name value to the desired file name. **NOTE:** it is recommended that there be no spaces in this name. Instead, use hyphens (i.e. “joe-smith”). Also, select the Parent Folder you want to save the block into.

3. In the “Link List” group, type in the title of the list, which will appear in the colored title bar.

4. In the “Link” group, type in the desired text of the link.

5. You can ink the text in one of three ways:
   - Link to a page within Cascade Server;
   - Link to a file (PDF, etc.) that has been uploaded into Cascade Server;
   - Link to an external Web site. **NOTE:** Failure to insert the http:// will result in the link being broken. If using an external Web site, select whether the link should open a new window or not.

6. **To Add a Link:** Find the “Link” group that you want to add the new block AFTER, then click the icon. Then follow Steps 4-6 above.

7. **To Delete a Link:** Find the “Link” group that you want to remove, and click the icon.

8. **To Sort the Links:** Find the “Link” group that you want to move up or down in the list, then click the ▲ or ▼ icon.

14.3. Create a Content Block
A Content Block allows you to add any content or JavaScript widget to the right column.

1. From the “New” menu, select Right Column > Content Block.

2. Change the System Name value to the desired file name. **NOTE:** it is recommended that there be no spaces in this name. Instead, use hyphens (i.e. “joe-smith”). Also, select the Parent Folder you want to save the block into.

3. In the “WYSIWYG Area” group, enter the desired content into the editor.

4. **Save the page.**

14.4. Create a Video Block
A Video Block allows you to insert a YouTube video into the right column, and provide a title and a thumbnail image.
1. From the “New” menu, select Right Column > Video Block.

2. Change the System Name value to the desired file name. **NOTE:** it is recommended that there be no spaces in this name. Instead, use hyphens (i.e. “joe-smith”). Also, select the Parent Folder you want to save the block into.

3. Fill in “Video Title” field with the video’s title.

4. Select the video’s thumbnail image in the “Video Thumbnail” field.

5. In the “YouTube ID” field, enter the 11-digit ID of the YouTube video you wish to display. Note that you do not need to enter the full YouTube URL, just the ID.

6. Click **Submit** to save the widget.

### 14.5. Display Content Block on a Page

Once your block has been created, you can now attach it to the site’s pages to display in the right column. Here are some notes about attaching blocks to a page:

- You can attach as many blocks to a page as you want.
- You can mix-and-match block types. In other words, you can add a callout block AND a link-content block to the same page.

To display a content block on a page:

1. Navigate to the desired page in Cascade Server, and go into Edit mode for that page.

2. Scroll down to the “Right Column” group.

3. In the “Content Blocks” group, use the page chooser to select the desired block you created in Section 4.1 or Section 4.2 above.

4. **To Add a Block:** Find the content block that you want to add the new block AFTER, then click the ▶️ icon. Then follow Steps 2-3 above.

5. **To Delete a Block:** Find the block that you want to remove, and click the □️ icon.

6. **To Sort the Blocks:** Find the block you want to move up or down in the list, then click the ▲ or ▼ icon.

7. Save the page.

### 14.6. Publishing

Depending on which action you perform, you may need to publish either the content block, the calling page, or both.
14.6.1. Adding/Modifying a Content Block
When adding or modifying a content block (Section 4.1 or 4.2), you will need to publish that asset.

14.6.2. Displaying Content on a Page
When displaying a content block on a main site page (Section 4.3), you will need to publish the main site page you are modifying. These actions include:

- Adding a block to the page;
- Deleting a block from the page;
- Sorting the blocks.
15. **GENERAL WORKFLOW**

Each University of Hartford user is a part of a workflow, set up to control the process for creating, editing, reviewing, and publishing content. Workflows are a valuable way to ensure that all content is properly reviewed before being published.

Listed below are some general notes about workflows that all users need to know:

1. All workflows that you either started or are participating in are listed on the Dashboard in the “Workflows” section.

2. Once a page has been submitted into a workflow, it can only be edited by the owner of the current workflow step. However, any user associated with the workflow can see the current state by clicking on the workflow name in the “Workflows” section. The current state is marked with 🔄.

3. Once a page has been submitted into a workflow, the workflow will need to be assigned to you. When you have taken ownership of a specific step, you will no longer need to assign the step to yourself.
4. All steps send out an email notification to the next step’s group. You will have the option of entering
   comments. All emails will come from webinfo@hartford.edu. The history of the workflow is displayed at
   the bottom of the email, and any entered comments from the previous step will be displayed at the very bottom
   of the email.

5. To access the page in the workflow, you can either click **View the workflow screen** in the email (you may
   need to log in), or click **My Workflows** on the Cascade Server dashboard, and then clicking the workflow
   name.

### 15.1. Contributors

All users have the ability to edit content and submit it into the above workflow. In this step, a contributor can either
initiate new content into a workflow, or edit content that has been rejected back to them by a reviewer.

#### 15.1.1. Submit New Content and Start the Workflow

1. Create or edit a page as you normally would. You may edit the page as many times as needed. You may
   also click the **Save as Draft** button to save a working copy of your page (see Section 3.8 above).

2. Once you have completed your edits and are ready to submit your changes, go into Edit mode on the
   edited page.

3. At the very bottom of the page, locate the “Advanced Options” section. You may need to click the link to
   expand this section.

4. In the “Start” section, check the box **Workflow**, and click **Submit**.

5. On the next screen, enter any comments you wish to send to the reviewer into the “Comments” field.

6. If you have a due date for your submitted content, change the “Due Date” field by clicking the Calendar
   icon.

7. Click **Submit**. Your assigned content reviewer will now be notified that your changes are ready for
   review. Note that you cannot edit this page again until the workflow is complete, or the workflow has
   been assigned back to you.

#### 15.1.2. Rejected Content

Once your content has been reviewed, more changes maybe needed as determined by your reviewer. If this is
the case, you will receive an email notification stating that your attention is needed regarding the workflow that
you created.

1. To access the rejected content, follow the instructions in Section 5, item #5 above.

2. In the “Properties” section, click the **Review Content** icon next to the page name. The page will be
   displayed.

3. Click the **Edit** tab. Make any necessary changes.
4. Click **Submit**.

**NOTE:** You will only be able to edit the page ONCE. When you click **Submit**, your changes will immediately be submitted, and you will not be able to edit the page again until the workflow is either completed, or the content is rejected back to you again.

If you know that you will need to modify and save the content more than once, follow the steps below:

1. Access the rejected content, follow the instructions in Section 5, item #5 above.

2. In the “Properties” section, click the **Review Content** icon next to the page name. The page will be displayed.

3. Click the **Edit** tab.

4. Copy all of the content.

5. Click the **View** tab at the top.

6. Under the blue bar, click on the name of the Workflow next to the “Workflow” label.

7. Click the **Delete** tab. On the warning page, click **Submit**. This will remove the page from the workflow.

8. You will now need to navigate to the page using the left navigation tree and edit the page as you normally would.

9. When you are ready to re-submit your changes, refer to Section 5.1.1 above for instructions.

**NOTE:** If you perform the above steps, all changes that were made when the page was entered into the workflow will be lost. This means that changes you made when you performed Step 3 in Section 5.1.1 will be lost.

15.2. **Publisher (Edit / Reject / Send to Editors / Send to Web Department / Publish)**

All users in the publisher group will receive an email stating that content is ready for review. Access the workflow using Section 5, Item #5 above.

1. The workflow now needs to be assigned to you. To do so, click **[Assign to Me]** in the “Workflow Group” section.

2. Under the “Ordered Step Name” section, click one of the three options listed:

15.2.1. **Approve for Publish**

Once the content has been approved by you, the workflow will move to the next step.

1. Click **Approve to Publish**. You can optionally enter comments.
2. Click Submit. The page will now be published to BOTH Development and Production.

15.2.2. Reject to Contributor

Rejects the submitted page back to the workflow owner (contributor) for their review.

1. After clicking Reject to Owner, enter any comments you wish to send to the original owner into the “Comments” field.

2. Click Submit. The owner will be notified via email that the changes have been rejected.

15.2.3. Edit Content

Allows you to make any desired edits to the current page before it moves to the next workflow step.

1. After clicking Edit Content, click Submit. You do not have to enter any comments. The page will be opened into Edit mode.

2. Make the desired edits and click Submit. You do not have to enter any comments. Click Submit.

3. If you wish to edit the content again, click Edit Content and follow the steps above. Otherwise, select another action.

15.2.4. Send to Editors

Sends the content to the Editor department for their review.

1. After clicking Send to Editors, enter any comments you wish to send to editors into the “Comments” field.

2. Click Submit. The editors will be notified via email that the changes have been submitted to them.

15.2.5. Send to Web Department

Sends the content to the Web Department for their review.

1. After clicking Send to Web Department, enter any comments you wish to send to Web department into the “Comments” field.

2. Click Submit. The editors will be notified via email that the changes have been submitted to them.

15.3. Editor Review (Edit / Reject / Send to Web Department / Approve for Publish)

All users in the Editor group will receive an email stating that content is ready for review. Access the workflow using Section 5, Item #5 above.

1. The workflow now needs to be assigned to you. To do so, click [Assign to Me] in the “Workflow Group” section.

2. Under the “Ordered Step Name” section, click one of the three options listed:
15.3.1. Approve for Publish

Once the content has been approved by you, the workflow will move to the next step.

1. Click Approve to Publish. You can optionally enter comments.

2. Click Submit. The page will now be submitted back to the Publisher.

15.3.2. Reject to Contributor

Rejects the submitted page back to the workflow owner (contributor) for their review.

1. After clicking Reject to Owner, enter any comments you wish to send to the original owner into the “Comments” field.

2. Click Submit. The page will not be submitted back to the Publisher, who will then send it back to the contributor.

15.3.3. Edit Content

Allows you to make any desired edits to the current page before it moves to the next workflow step.

1. After clicking Edit Content, click Submit. You do not have to enter any comments. The page will be opened into Edit mode.

2. Make the desired edits and click Submit. You do not have to enter any comments. Click Submit.

3. If you wish to edit the content again, click Edit Content and follow the steps above. Otherwise, select another action.

15.3.4. Send to Web Department

Sends the content to the Web Department for their review.

1. After clicking Send to Web Department, enter any comments you wish to send to Web department into the “Comments” field.

2. Click Submit. The editors will be notified via email that the changes have been submitted to them.

15.4. Web Department Review (Edit / Reject / Send to Editors / Approve for Publish)

All users in the Web Department group will receive an email stating that content is ready for review. Access the workflow using Section 5, Item #5 above.

1. The workflow now needs to be assigned to you. To do so, click [Assign to Me] in the “Workflow Group” section.

2. Under the “Ordered Step Name” section, click one of the three options listed:
15.4.1. Approve for Publish

Once the content has been approved by you, the workflow will move to the next step.

1. Click Approve to Publish. You can optionally enter comments.

2. Click Submit. The page will now be submitted back to the Publisher.

15.4.2. Reject to Contributor

Rejects the submitted page back to the workflow owner (contributor) for their review.

1. After clicking Reject to Owner, enter any comments you wish to send to the original owner into the “Comments” field.

2. Click Submit. The page will not be submitted back to the Publisher, who will then send it back to the contributor.

15.4.3. Edit Content

Allows you to make any desired edits to the current page before it moves to the next workflow step.

1. After clicking Edit Content, click Submit. You do not have to enter any comments. The page will be opened into Edit mode.

2. Make the desired edits and click Submit. You do not have to enter any comments. Click Submit.

3. If you wish to edit the content again, click Edit Content and follow the steps above. Otherwise, select another action.

15.4.4. Send to Editors

Sends the content to the Editors for their review.

1. After clicking Send to Editors, enter any comments you wish to send to Web department into the “Comments” field.

2. Click Submit. The editors will be notified via email that the changes have been submitted to them.
16. **RESLIFE WORKFLOW**

To use the workflow that has been applied to the Residential Life section:

### 16.1. Contributor

The Contributor has the ability to edit content and submit it into the above workflow. In this step, a contributor can either initiate new content into a workflow, or edit content that has been rejected back to them by the reviewer.

#### 16.1.1. Submit New Content and Start the Workflow

1. Create or edit a page as you normally would. You may edit the page as many times as needed. You may also click the **Save as Draft** button to save a working copy of your page (see Section 3.8 above).

2. Once you have completed your edits and are ready to submit your changes, go into Edit mode on the edited page.

3. At the very bottom of the page, locate the “Advanced Options” section. You may need to click the link to expand this section.

4. In the “Start” section, check the box **Workflow**, and click **Submit**.

5. On the next screen, enter any comments you wish to send to the reviewer into the “Comments” field.

6. If you have a due date for your submitted content, change the “Due Date” field by clicking the Calendar icon.

7. Click **Submit**. The reviewer will now be notified that your changes are ready for review. Note that you cannot edit this page again until the workflow is complete, or the workflow has been assigned back to you.

#### 16.1.2. Rejected Content

Once your content has been reviewed, more changes may be needed as determined by the Publisher. If this is the case, you will receive an email notification stating that your attention is needed regarding the workflow that you created.

1. To access the rejected content, follow the instructions in Section 16, item #5 above.

2. In the blue bar just below the “View” tab, click **History**. You will find the comments from your approver in the last row of the table, at the bottom of the page.

3. In the blue bar just below the “View” tab, click **Properties**.

4. In the “Actions” section, click the **Edit Asset**.

5. Make any necessary changes to the page, and then click **Submit**.
6. You do not have to type anything into the “Comments” field at this time, so click **Submit**.

7. To review the changes you just made, in the “Properties” section, click the **Review Content** icon next to the page name. The page will be displayed again.

8. Just below the Asset Action Toolbar, find the “Workflow” line, and click on the link next to the word “Workflow” to return to the workflow screen.

9. If you need to make additional changes to this page before submitting it to your approver, in the “Actions” section near the bottom of the screen, click **Edit Asset**. Then follow Steps 5-8 above.

10. If you are done editing and wish to re-submit your changes to your approver, in the “Actions” section near the bottom of the screen, click **Submit to Publisher for Approval**.

11. On the next screen, enter any comments you wish to send to your approver into the “Comments” field.

12. Click **Submit**. Your approver will now be notified that your changes are ready for review. Note that you cannot edit this page again until the workflow process is complete.

### 16.2. Publisher

The Publisher user will receive an email stating that content is ready for review. Access the workflow using Section 16, Item #5 above.

1. In the blue bar just below the “View” tab, click **History**. You will find the comments from the contributor in the last row of the table at the bottom of the page.

2. To review the changes that have been submitted to you, in the “Properties” section, click the **Review Content** icon next to the page name. The page will be displayed. Review the changes.

3. Just below the Asset Action Toolbar, find the “Workflow” line, and click on the link next to the word “Workflow”.

4. In the “Actions” section, click one of the options listed below.

#### 16.2.1. Edit Asset

Allows you to make any desired edits to the current page before it moves to the next workflow step.

1. In the “Actions” section, click **Edit Asset**.

2. You do not have to type anything into the “Comments” field at this time, so click **Submit**. The page will open in Edit mode.

3. Make the desired edits and click **Submit**.

4. You do not have to type anything into the “Comments” field at this time, so click **Submit**.
6. If you wish to edit the content again, click Edit Asset and follow the steps above. Otherwise, select another action.

### 16.2.2. Reject to Contributor

Rejects the submitted page back to the contributor for their review.

1. In the “Actions” section, click Reject to Contributor.
2. Enter any comments you wish to send to the contributor into the “Comments” field.
3. Click Submit. The contributor will be notified via email that the changes have been rejected.

### 16.2.3. Approve and Send to Editor

Sends the workflow to the Editor for their review and approval.

1. In the “Actions” section, click Approve and Send to Editor.
2. Enter any comments you wish to send to the reviewer into the “Comments” field.
3. Click Submit. The reviewer will be notified via email that the workflow is ready for their review.

### 16.3. Editor

The Editor user will receive an email stating that content is ready for review. Access the workflow using Section 16, Item #5 above.

1. In the blue bar just below the “View” tab, click History. You will find the comments from the contributor in the last row of the table at the bottom of the page.
2. To review the changes that have been submitted to you, in the “Properties” section, click the Review Content icon next to the page name. The page will be displayed. Review the changes.
3. Just below the Asset Action Toolbar, find the “Workflow” line, and click on the link next to the word “Workflow”.
4. In the “Actions” section, click one of the options listed below.

#### 16.3.1. Edit Asset

Allows you to make any desired edits to the current page before it moves to the next workflow step.

1. In the “Actions” section, click Edit Asset.
2. You do not have to type anything into the “Comments” field at this time, so click Submit. The page will open in Edit mode.
3. Make the desired edits and click Submit.

4. You do not have to type anything into the “Comments” field at this time, so click Submit.

5. If you wish to edit the content again, click Edit Asset and follow the steps above. Otherwise, select another action.

16.3.2. Reject to Contributor
Rejects the submitted page back to the contributor for their review.

1. In the “Actions” section, click Reject to Contributor.

2. Enter any comments you wish to send to the contributor into the “Comments” field.

3. Click Submit. The contributor will be notified via email that the changes have been rejected.

16.3.3. Reject to Publisher
Rejects the submitted page back to the Publisher for their review.

1. In the “Actions” section, click Reject to Publisher.

2. Enter any comments you wish to send to the contributor into the “Comments” field.

3. Click Submit. The publisher will be notified via email that the changes have been rejected.

16.3.4. Approve and Send to Designer
Sends the workflow to the Designer for their review and approval.

1. In the “Actions” section, click Approve and Send to Designer.

2. Enter any comments you wish to send to the reviewer into the “Comments” field.

3. Click Submit. The reviewer will be notified via email that the workflow is ready for their review.
16.4. Designer

The Designer user will receive an email stating that content is ready for review. Access the workflow using Section 16, Item #5 above.

1. In the blue bar just below the “View” tab, click History. You will find the comments from the contributor in the last row of the table at the bottom of the page.

2. To review the changes that have been submitted to you, in the “Properties” section, click the Review Content icon next to the page name. The page will be displayed. Review the changes.

3. Just below the Asset Action Toolbar, find the “Workflow” line, and click on the link next to the word “Workflow”.

4. In the “Actions” section, click one of the options listed below.

16.4.1. Edit Asset

Allows you to make any desired edits to the current page before it moves to the next workflow step.

1. In the “Actions” section, click Edit Asset.

2. You do not have to type anything into the “Comments” field at this time, so click Submit. The page will open in Edit mode.

3. Make the desired edits and click Submit.

4. You do not have to type anything into the “Comments” field at this time, so click Submit.

5. If you wish to edit the content again, click Edit Asset and follow the steps above. Otherwise, select another action.

16.4.2. Reject to Contributor

Rejects the submitted page back to the contributor for their review.

1. In the “Actions” section, click Reject to Contributor.

2. Enter any comments you wish to send to the contributor into the “Comments” field.

3. Click Submit. The contributor will be notified via email that the changes have been rejected.
16.4.3. Reject to Publisher
Rejects the submitted page back to the Publisher for their review.

1. In the “Actions” section, click Reject to Publisher.

2. Enter any comments you wish to send to the contributor into the “Comments” field.

3. Click Submit. The publisher will be notified via email that the changes have been rejected.

16.4.4. Reject to Editor
Rejects the submitted page back to the Editor for their review.

1. In the “Actions” section, click Reject to Editor.

2. Enter any comments you wish to send to the contributor into the “Comments” field.

3. Click Submit. The editor will be notified via email that the changes have been rejected.

16.4.5. Approve and Publish
Completes the workflow and publishes the asset.

1. In the “Actions” section, click Approve and Publish.

2. Enter any comments you wish to send to the contributor into the “Comments” field.

3. Click Submit. The asset will be published, and the Contributor will be notified that the workflow is complete.

16.5. Right Column Workflow
The ResLife Publisher will need to use a workflow to publish right column content blocks. To do this:

1. Create, edit, or delete any asset in the “right-column” folder.

2. When done, check the “Start Workflow” checkbox, then click Submit.

3. On the next screen, you do not need to enter any comments. Click Submit. The asset will be published (or un-published if deleting).
17. **HOMEPAGE**

17.1. **Special Message**

The Special Message section is the large image with a text overlay. In this area, you can specify the image, overlay text, and the text’s position within the image (left, center, or right). Alternatively, you can create the image with the red overlay background and text embedded in the image.

**NOTE:** The graphical red bar (without the text) will need to be saved as part of the photo in Photoshop and uploaded to Cascade. The red bar can be aligned left, center or right on the image with a 24 px margin on the left or right side.

If you want to overlay text on top of the image without embedding the text within the image:

1. Edit the homepage (/default). Find the “Special Message” section, and click on the blue title to expand it.

2. Select the desired image in the “Image” field. Note that the required size is 621 pixels wide by 502 pixels high.

3. To horizontally position the overlay text within the image, in the “Overlay Position” field, select Left, Center, or Right.

4. Find the “Special Message >> Title” group to set the image’s title text.
   a. In the “Text” field, enter your first line of larger white text, which will appear at the top of the image.
   b. Determine whether the line of text will be bold or italicized in the “Style” field.
   c. To add a line, use the + icon. Note that each line can contain a maximum of eight characters, and you can have a maximum of 4 lines.

5. In the “Caption” field, enter the smaller white text that will appear below the title text.

6. You can optionally link the text in one of three ways:
   - Link to a page within Cascade Server;
   - Link to a file (PDF, etc.) that has been uploaded into Cascade Server;
   - Link to an external Web site. Note that you must enter the entire URL of the Web site (i.e. http://www.beacontechnologies.com/). **NOTE:** Failure to insert the http:// will result in the link being broken. If using an external Web site, select whether the link should open a new window or not.
17.2. Areas of Study

The Areas of Study section resides below the Special Message feature. Within Cascade Server, you can modify the values in the “All Areas of Study” dropdown, as well as the slides within the rotating feature.

17.2.1. All Areas of Study

To modify the values in the “All Areas of Study” dropdown field:

1. Edit the homepage (/default). Find the “Areas of Study” section, and click on the blue title to expand it. Then, click on the “Areas of Study >> Link” section that you want to modify.

2. Enter the desired link text in the “Link Text” field.

3. You can optionally link the text in one of three ways:
   - Link to a page within Cascade Server;
   - Link to an external Web site. Note that you must enter the entire URL of the Web site (i.e. http://www.beacontechnologies.com/). NOTE: Failure to insert the http:// will result in the link being broken. If using an external Web site, select whether the link should open a new window or not.

4. Add, remove, and sort the links as desired:
   a. To Add a Link: Find the “Areas of Study >> Link” group that you want to add the new block AFTER, then click the icon. Then follow Steps 4-6 above.
   b. To Delete a Link: Find the “Areas of Study >> Link” group that you want to remove, and click the icon.
   c. To Sort the Links: Find the “Areas of Study >> Link” group that you want to move up or down in the list, then click the ▲ or ▼ icon.

17.2.2. Slideshow

To maintain the slideshow within this area, navigate to the following folder: /_internal/blocks/xhtml/callouts/spotlights. Each block of HTML will be included in the slideshow. To sort the order in which they appear in the slideshow, see Section 8.2 to sort the items.

To Publish: The assets you’re editing are not publishable. Thus, you must publish the homepage.

17.3. Mobile Icons

The mobile site’s homepage allows you to specify an icon, its title, and where it links to.

1. Edit the homepage (/default). Find the “Mobile Icons” section, and click on the blue title to expand it. Then, click on the “Mobile Icons >> Icon” section that you want to modify.

2. Select the desired icon in the “Image” field.

3. Enter the icon’s title in the “Title” field.
4. You can optionally link the icon in one of three ways:
   - Link to a page within Cascade Server;
   - Link to a file (PDF, etc.) that has been uploaded into Cascade Server;
   - Link to an external Web site. Note that you must enter the entire URL of the Web site (i.e. http://www.beacontechnologies.com/). **NOTE:** Failure to insert the http:// will result in the link being broken. If using an external Web site, select whether the link should open a new window or not.

5. Add, remove, and sort the icons as desired:
   a. **To Add an Icon:** Find the “Mobile Icons >> Icon” group that you want to add the new block AFTER, then click the icon. Then follow Steps 4-6 above.
   b. **To Delete an Icon:** Find the “Mobile Icons >> Icon” group that you want to remove, and click the icon.
   c. **To Sort the Icons:** Find the “Mobile Icons >> Icon” group that you want to move up or down in the list, then click the or icon.

18. **Emergency Site**

To use the Emergency Site, please navigate to the “Emergency” site in Cascade Server’s Site dropdown menu.

**Images** On the Emergency site, you can use any images from throughout the system. Additionally, you can house the Emergency site images in the Emergency site’s “images” folder.

**URL:** The published Emergency site will be located at: http://www.hartford.edu/emergency

18.1. **Emergency Message**

The Emergency Message automatically forwards all Web site visitors to the Emergency page, no matter what page they are viewing on the Main or Library site. To manage this message:

18.1.1. **Activate**

1. Edit the “default” page.

2. In the “Active Message field, select “Emergency”.

3. Click on the “Emergency / Post-Emergency Message” blue title to expand the section.

4. Enter the desired title and content for the page into the “Title” and “Content” fields.

5. Click **Submit** to save the page.

6. **To Publish:** Publish the current page. Upon doing so, every page across the site will forward to this page.
18.1.2. Deactivate
1. Edit the “default” page.
2. In the “Active Message” field, make another selection, or select “None” to completely turn off the message.
3. Click Submit to save the page.
4. To Publish: Publish the current page.

18.2. Post-Emergency Message
The Post-Emergency message is managed the same way as the Emergency Message (Section 18.1 above). When the Post-Emergency Message is active, only the main site homepage will forward to the Emergency Site page. All other pages will not forward.

18.3. President/Provost Tragedy Message
The President/Provost Tragedy Message automatically forwards all visitors of the main site homepage to either a site page, or to an external Web site. To manage this message:

18.3.1. Activate
1. Edit the “default” page.
2. In the “Active Message field, select “Pres/Prov Tragedy”.
3. Click on the “Pres/Prov Tragedy Message” blue title to expand the section.
4. To link to another page within Cascade Server, in the “Link to Page” field, select the desired page. If you want to link to an external URL, enter the full URL into the “OR Link to External URL” field. If linking to an external URL, in the “Link to External URL opens in a new window?” field, select whether you want the URL to be opened in a new window or not (recommended is “Yes”).
5. Click Submit to save the page.
6. To Publish: Publish the current page. Upon doing so, the main site homepage will forward to the selected page or external Web site.

18.3.2. Deactivate
1. Edit the “default” page.
2. In the “Active Message” field, make another selection, or select “None” to completely turn off the message.
3. Click Submit to save the page.
4. To Publish: Publish the current page.